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NCDOT CONGESTION MANAGEMENT SIMULATION GUIDELINES -
TRANSMODELER

This document provides standards to ensure consistent traffic analysis done by/for the North Carolina Department
of Transportation (NCDOT) Congestion Management Section using TransModeler traffic simulation software. The
utilization of advanced traffic simulation software requires an understanding of traffic engineering principles and
the ability to make sound engineering judgments. In certain circumstances, deviation (within certain parameters
defined in these guidelines) from these guidelines will, may, or will not be allowed. Within this document, the
term shall defines parameters that cannot be modified without prior approval from the NCDOT Congestion
Management Section. Additionally, the term should is utilized where any deviation from these guidelines or any
default parameter requires justification and documentation. The term may represents conditions that are at the
discretion of the analyst. The information and guidance included in these Guidelines is neither all inclusive, nor
should they be considered to be completely rigid. The intent of these Guidelines is to provide reasonable bounds
for developing simulation studies in a consistent manner, but remain flexible enough to handle unique situations
when warranted, properly justified and fully documented. The goal of utilizing advanced simulation is to provide
the most realistic analysis possible. It is the responsibility of the analyst preparing the models to develop them in
a manner that is technically sound. The flexibility allowed in these Guidelines should be utilized, when needed, to
meet this goal. Strict adherence to the Guidelines shall not be used as an explanation as to why something was,
or was not, done during the development of an analysis. By reviewing reports, plans, and submittals, the NCDOT
in no way relieves the analyst of possible claims or additional work resulting from errors or omissions.

This version of the Guidelines shall apply to all projects that have a Notice to Proceed issued after the Effective
Date listed in the footer of this document.

These Guidelines were developed for projects being completed for the NCDOT Congestion Management Section
and include requirements that deviation from these Guidelines be approved. These Guidelines are limited to
capacity analysis studies only, detailed operational studies, such as field signal timing may have different
requirements. These Guidelines may be utilized for projects that are not being prepared for the NCDOT
Congestion Management Section, such as projects at the Division level, at the discretion of the responsible NCDOT
Business Unit. For Non-Congestion Management Section projects, substitution of the responsible NCDOT Business
Unit throughout these Guidelines where NCDOT Congestion Management Section approval is required is
acceptable.

FILE SETUP
This section includes a summary of the NCDOT default files and settings for TransModeler modeling. It also
includes guidelines for folder and file naming for all modeling projects.

Default File — Project Archive
The NCDOT Default TransModeler database (current version: NCDOT_Default_09-2016.zip) is available from the
Congestion Management Section website (https://connect.ncdot.gov/resources/safety/Pages/Congestion-
Management.aspx). The default file is a zip file that was created as a Project Archive in TransModeler and includes
the default parameters for projects being analyzed by NCDOT.

The zip file that includes the project archive shall be downloaded and extracted to the appropriate project folder
prior to developing the model.
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Default File — Project Preferences
In TransModeler, there are a wide variety of preferences for controlling the map and layer styles, default project
settings, and other options within simulation databases. The NCDOT Default Project Preferences file
(tsm_user.xml) is available from the Congestion Management Section website
(https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx). These preferences are
included under >Project>Preferences for TransModeler. The project preferences are utilized in TransModeler SE;
however, the dialog box to modify preferences is not available in TransModeler SE.

The Project Preferences generally are settings that do not affect the actual operations of the model; therefore,
their use is recommended, but not mandatory.

To utilize the NCDOT default project preferences the tsm_user.xml file must be copied into the directories, where
the user text is replaced by the Windows User Name on the computer utilizing the software.

TransModeler 2 C:\Users\user\AppData\Roaming\Caliper\TransModeler 4.0\tsm_user.xml|
TransModeler SE - C:\Users\user\AppData\Roaming\Caliper\TransModeler SE 4.0\tsm_user.xml|
Note: the AppData folder may be hidden in Windows.

The list of default preferences modified in the Project Preference file are included in Attachment A.

Default File = NCDOT Default Parameters

TransModeler includes a default set of global model and driver behavior parameters that apply to all simulation
projects. NCDOT is currently developing a set of parameters that are representative of the general traffic
operations experienced in North Carolina that can be used as default parameters in simulation. Until this
evaluation is completed, a set of NCDOT defaults has been developed based on the existing experience in using
TransModeler and shall be utilized for all simulation projects. It is not possible to create one set of parameters
that will be valid for all projects across the state; however, the default parameters should provide a good starting
point for developing a model. Modification of the default parameters is discussed in detail in the Visual Validation
and Calibration sections of these guidelines.

The NCDOT Default Parameter files were developed based on the terrain of the project (level, rolling or
mountainous) and shall be utilized based on the terrain within the project study area being modeled. The terrain
for the project study area shall be based on the definitions included in the latest version of the AASHTO Policy on
Geometric Design of Highways and Streets. If grades are not being utilized, the level terrain parameters file shall
be used.

The list of default parameters modified in the NCDOT Default Parameters file are included in Attachment A.

Folder Naming Conventions
TransModeler is based on a Geographic Information System (GIS); therefore, it has a large number of files

associated with each simulation project. Prior to September 2016, most projects were developed with all of the
analysis files included in a single folder. While this is still acceptable, especially for models developed prior to
September 2016, the desire is now to have a more orderly folder structure.

Each unique model developed in TransModeler shall be included in its own separate set of folders. The
TransModeler model files shall be placed in a folder with the following naming standard:

{TIP or Project No.} {Analysis Year or Years} {Scenario} {Alternative (if applicable)}
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With:
TIP or Project No.: STIP, Special Project (SP) or SPOT ID

Analysis Year or Years: Analysis Year for Model or Years if multiple analysis years are included in
a single model

Scenario: No-Build, Build or some other special scenario

Alternative: Alternative name/number or additional information to distinguish between differing
options or scenarios

For Example: U-0000_2016_No-Build
R-0000_2016-2040_No-Build

[-0000_2040_Build_Alternative 1

Within the model folder, subfolders are included with the following names and descriptions:

Database = TransModeler database (.dbd) and associated files

Input Files = Model input files listed under >Project Settings>Input>Input Files, including signals,
pedestrians (if applicable) and turn prohibitions (if applicable)

Input Volumes = Volume input files (.mtx for matrix or .bin for turning movements). Includes AM and PM
subfolders

Output = Output data from simulation runs. Includes AM and PM subfolders
Parameters = Default Parameters file (.xml) based on terrain

Routing = Dynamic traffic assignment and historic routing files, if applicable. Includes AM and PM
subfolders.

File Naming Conventions

Once completed, all model files developed in TransModeler will be stored in a database and will be made available
for future analysis efforts. Therefore, they need to be developed in a manner that allows them to be easily
followed for any future analyst who may need to work with the model.

The following are the required naming conventions for each file:

Simulation Project File (.smp) shall have the same name as the overall simulation folder described above
in the folder naming conventions:

{TIP or Project No.} {Analysis Year or Years} {Scenario} { Alternative (if applicable)}.smp

Simulation database (.dbd) and associated files shall have the same name as the .smp file

Turning Movement files (.bin) shall have the same name as the .smp file with “_TMC” appended, along
with any additional information or descriptors, following the Alternative portion of the file name

Matrix files (.mtx) shall have the same name as the .smp file with any additional information appended
following the Alternative portion of the file name. Any matrices used for the warm-up period shall have
“_warmup” appended to the file name to designate them as warmup period matrices.
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e Input files (Signals, Incidents, Pedestrians, Detour Paths, Turn Prohibitions) shall follow the same file
naming convention as the .smp file with any additional information appended to the end of the file name.

e Routing files (Historical and Turning Delay) shall follow the same file naming convention as the .smp file
with “_Historical” and _Turning Delay” appended, along with any additional information (such as AM and
PM), to end of the file name.

e Parameters files (.xml) shall maintain the same name as in the Project Archive
(NCDOT_Default_Parameters_Date_Terrain.xml). However, if any default parameters are modified due
to visual validation or calibration the file should be renamed with the _Default_ portion of the file name
modified to the TIP or Project Number and the _Date_ portion updated to the date of the modification.
For example, if a model for U-0000 modified default parameters in December 2016, the file would be
renamed: NCDOT_U-0000_Parameters_12-2016_Level.xml

e Project Archives (.zip) shall follow the same file naming convention as the .smp file with the date of the
archive appended to the end of the file name.

PROJECT SETTINGS

In order to simulate traffic, TransModeler requires a variety of input files and parameters for each scenario in a
project. The Project Settings dialog box (>Project>Settings) includes several tabs that should be reviewed and
properly configured for each scenario being modeled. A single simulation project can include multiple scenarios
as long as they all have the same simulation network. For example, a 2016 Existing and 2040 No-Build analysis
could be completed with a single simulation file, if there are no changes in the network, with AM and PM scenarios
being included for each analysis year. Typically, each simulation project will include both the AM and PM analyses
in a single file with each peak period being an individual scenario.

The naming convention for scenarios follows a similar structure as the file naming conventions described earlier:
{TIP or Project No.} {Analysis Year or Years} {Scenario} {Alternative (if applicable)} {Time Period (AM/PM)}

For example: U-0000_No-Build_2016_AM or R-0000_Build_2040_Alternative 3_PM

Setup Tab
The information included on the Setup tab establishes the basic project scope, including information such as the

start and end time of the simulation. For all simulation projects, the Warm-up Period should be determined to be
the greater of either 15 minutes or the expected travel time for the longest path within the model. Each scenario
shall include a Warm-up Period followed by a one-hour period for simulation with the AM peak simulation hour
being from 8:00-9:00 AM and the PM peak simulation hour being from 5:00-6:00 PM. Therefore, the Simulation
Period Start Time shall be set to a time prior to 8:00 AM or 5:00 PM equal to the Warm-up Period duration. The
Simulation Period End Time for single hour simulation projects shall end at 9:00 AM or 6:00 PM. The Initial State
settings shall be set to Empty and the Warm-up Period described above shall be included. Under the Show
Optional Project Settings, the Routing and Parameters options shall both be selected.

Network Tab
The network tab includes the information about the network database in TransModeler and allows the turning
movement database file (.dbd) to be defined. The Road Network — Database field shall include the project
database including the proper folder and file naming conventions. The Turning Movement Variables — Table field
should define the turning movement data for any project utilizing turning movements to optimize isolated signals.
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Input Tab
The input tab includes the most common input files to the simulation analysis. The Trip Tables shall include either

the input O-D matrix (.mtx) volume files or the input Turning Movement Files (.bin) that are to be utilized to
simulate traffic during the model runs. The use of O-D matrices or Turning Movement Volumes is discussed in
further detail in the Volume Input section.

Additionally, the input files for signals and, if applicable, the Incidents, Pedestrians, HOT Lanes, Detour Paths and
Turn Prohibitions shall be included on the Input tab.

Output Tab
The output tab determines which raw output statistics are to be collected in each model run. For additional

information on outputs, please see the Measures of Effectiveness section.

Routing Tab
The routing tab includes the inputs and settings to the route choice model utilized in the simulation. The default

settings for Route Choice include the Method being set to Stochastic Shortest Path and the options for Use Turning
Delays, Enforce Free Flow Travel Time as Minimum and Enforce Global Turning Delays as Minimum being selected.

For projects that utilize Dynamic Traffic Assignment (DTA), the Travel Time and Turn Delay fields for Historical and
Turning delay shall be utilized. For additional information on DTA and Routing please see the Dynamic Traffic
Assignment section.

Global Turning Delays shall be set to 10 seconds for right turns, 0 seconds for through, 15 seconds for left turns
and 20 seconds for U-turns.

Parameters Tab
The parameters tab includes the definition of the parameters file that sets the global model and driver behavior
parameters that apply to the simulation project. The Model Parameters — Parameters field shall include the
appropriate NCDOT_Default_Parameters file (.xml) based on the terrain of the project. If the project includes
visual validation where parameters are modified, the modified parameters file (renamed with the proper naming
convention) shall be attached. The default step size shall be set to 0.1 seconds for microscopic simulation.

Options Tab
The options tab includes several options that do not have any effect on the simulation and the default values

should be maintained.

MODEL DEVELOPMENT
This section includes the guidelines for developing models in TransModeler.

Background for Model Development
The development of models is typically done utilizing aerial imagery for existing conditions models and GIS
shapefiles for proposed designs.

There are several sources and methods for utilizing aerial imagery in TransModeler, including:

e NC OneMap = high resolution aerial imagery collected on a rotating basis every three years. The data
can be downloaded and utilized at any time without a network connection. Once the files are downloaded
they can be stored locally on a computer or server and referenced into the model. Available at:
http://data.nconemap.gov/geoportal/catalog/raster/download.page
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e Web Map Layer = TransModeler includes commercially available aerial imagery as Web Map Layers that
can be accessed with a network connection. The map layers include maps and imagery from Google,
OpenStreetMap, USGS and Virtual Earth. The imagery is available in TransModeler through the
>Tools>Imagery>Web Map Layers menu and on the >Tools>Toolbar>Web Map Layers Toolbar for
TransModeler SE.

e Project Specific Aerials = If project specific aerials are available in a standard imagery format, they shall
be attached in a coordinately correct manner.

In addition to the ability to download NC OneMap imagery, the aerial image data is available with a pair of custom
Web Map Layer settings files (NCOneMap(Latest)High.xml and NCOneMap(Latest)Low.xml) that are available
from the Congestion Management Section website
(https://connect.ncdot.gov/resources/safety/Pages/Congestion-Management.aspx). To be available in the list of
Web Map Layers in TransModeler and TransModeler SE, the files must be copied into the following directory:

TransModeler = C:\Users\user\ My Documents\Caliper\TransModeler 4.0\WebMapServices\
TransModeler SE = C:\Users\user\ My Documents\Caliper\TransModeler SE 4.0 \WebMapServices\

Background data files are attached to the model as layers. If a model is being developed in TransModeler and
includes more than ten image files, they should first be included in an image library (.cil) file developed using the
image librarian toolbox under >Tools>Imagery>Image Librarian> and not be attached directly to the model as
individual layers. This ability to create .cil files is not available in TransModeler SE; therefore, if the project is
developed inTransModeler SE and has more than 10 image files, it is acceptable to attach them as layers.

Design Data in Microstation or AutoCAD format must first be exported to a supported file type before being
referenced into TransModeler as a layer. Two methods are available for importing design data into TransModeler:

e ESRI Shapefile (.shp) attached as a layer to your model
e Microstation V7 file (.dgn) converted to a .dbd file

An ESRI Shapefile (.shp) is the most common file type for referencing design data into TransModeler. However, a
Microstation design file may be saved as a V7 file in Microstation and then opened (>File>Open) in TransModeler.
The file then may be saved as a .dbd database file and can be added as a layer to the model.

TransModeler is a geographic information system (GIS) based program and operates based on latitude/longitude;
therefore, design data should be imported/exported with the following settings:

e Coordinate System Class: North America NAD83 (US State Plane)
e Coordinate System Zone: 3200: North Carolina

e Unit Conversion — Interpret as Units: Feet

e Datum Conversion Method: No Change

Merging Previously Developed Models
One of NCDOT'’s primary goals for TransModeler is to be able to utilize previously developed models and not re-
create the model networks each time an area is modeled. NCDOT Congestion Management Section is in the
process of developing a GIS layer and database of all of the completed TransModeler models in North Carolina.
Until this is fully operational, the analyst shall check with the appropriate NCDOT Congestion Management Section
staff member to determine if existing models are available for the project study area.
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If an existing model is available, the previous model database (.dbd file) and signal plan data (.tms file) shall be
merged into a single model database and signal plan with the same file name as the new model. The merged data
should then be copied into the project directory, overwriting the previous data, such that all of the settings in the
simulation project file (.smp file) are maintained.

Fiscal Constraint for Future Year Models
When developing future year models, the analyst shall review the pertinent plans listed below to determine if any
additional reasonably foreseeable projects, beyond the subject project being modeled, are located within the
model study area. Any project that is reasonably foreseeable should be included in the future year model(s). The
following criteria shall be used to determine if a project is reasonably foreseeable:

e For model study areas located within the boundaries of a Metropolitan Planning Organization (MPO), the
currently adopted Long Range Transportation Plan (LRTP) or Metropolitan Transportation Plan (MTP) shall
be reviewed to determine if any projects within the model study area are included on the fiscally
constrained list of projects. These projects shall be included in the analysis.

e Foranon-MPO area, any project located within the model study area that has construction funding in the
current State Transportation Improvement Program (STIP) shall be included in the analysis.

Link Coding
Road Class
In TransModeler, each link is assigned a road class that distinguishes different types of facilities by basic traffic
flow parameters. All links in a model shall be coded with the appropriate Road Class. NCDOT has developed a
custom set of Road Classes (included in Attachment B) that are based on the facility type and speed limit. The
selection of the Road Class should be based on the NCDOT Functional Classification Map
(http://ncdot.maps.arcgis.com/home/webmap/viewer.html?layers=029a9a9fe26e43d687d30cd3c08b1792).
The following facility types and their corresponding functional classification are available in the Road Class library:

e Freeway - Interstate and Other Freeway

e Directional Ramp, Ramp and Loop

e Arterial > Other Principal Arterial and Minor Arterial
e Collector = Major Collector and Minor Collector

e Local - Local

e Roundabout

e Arterial_DDI

For Freeways, Arterials, Collectors and Local roadways, the Road Class should be selected based on the posted
speed limit of the facility. For roadways that do not have a posted speed limit, an appropriate speed limit should
be selected and documented in the model documentation.

Directional Ramps should be used whenever a ramp is making a high speed (non-loop) freeway to freeway
connection and the default speed limit should be 50 mph. If detailed design information is available, then
deviation from the default speed is acceptable, if properly documented in the model documentation.

The Ramp road class should be used for non-freeway to freeway ramp connections and the default speed limit
should be 45 mph. If detailed design information is available, then deviation from the default speed is acceptable,
if properly documented in the model documentation.
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The Loop road class should be used for all loop connections along a freeway and the default speed limit should be
25 mph. If detailed design information is available that indicates different design speeds, then deviation from the
default speed is acceptable, if properly documented in the model documentation.

In order to properly develop Measures of Effectiveness for freeways, TransModeler requires that all connections
between the Freeway Road Class and the Arterial, Collector and Local Road Classes include a transition roadway
with a Directional Ramp, Ramp or Loop Road Class. Therefore, all freeway facilities shall be modeled with
appropriate transitional ramp elements. If a facility operates as an Expressway with only limited control of access
and lower speed (non-ramp or loop) access points, then it should be modeled with the Arterial Road Class.

All Roundabouts shall be coded with the circulatory roadway having the Roundabout Road Class. For single lane
roundabouts with an inscribed diameter less than 120 feet, the default speed limit should be 20 mph while the
default speed limit for an inscribed diameter of 120 feet or more should be 25 mph. If detailed design data is not
available for roundabouts, single lane roundabouts should have an inscribed diameter of 120 feet and multi-lane
roundabouts should have an inscribed diameter of 150 feet,

The operations of Diverging Diamond Interchanges (DDI) differ slightly from those of standard arterials or collector
roadways in that drivers tend to exhibit a more uniform speed distribution that does not deviate substantially
from the posted speed within the DDI interchange. Therefore, it is recommended that all DDI’s be coded with the
Arterial_DDI Road Class with the Road Class speed limit being selected based on the geometry of the DDI and
should be included in the model documentation. Consideration should be given to the crossing angle of the DDI
and the design speed with which drivers are able to navigate the design, which is frequently less than the posted
speed of the adjacent facility.

It should be noted that the use of the Functional Classification Maps is relatively new and that models developed
previously were likely not developed based on these criteria; therefore, any previously developed model being
utilized shall be reviewed and updated according to the guidance provided above. Additionally, models developed
prior to July 2015 may include Road Classes defined based on a previous naming convention. Before merging a
model into the default file, the analyst should update the road classes in the previous model to the current
definitions and remove the old road classes from the file. This can be accomplished by:

Adding a new column to link Dataview and then copying the Road Class field into that column
Changing all of the road classes to undefined (using fill command)

Delete all of the existing road classes from the >Parameters>Edit Road Class dialog box
Import the existing road class file Road Class Definitions.xml file

Update the road classes for each link based on the attributes from the previous model

e wNe

If the model network includes a roadway that does not match any of the default Road Classes, then a new Road
Class should be added with appropriate settings and documented in the model documentation. For new Road
Class definitions, the Desired Speed Distribution should be set based on the most similar default Road Class.

Desired Speed Distributions

The Desired Speed Distributions in TransModeler reflect the reality that not all vehicles travel at the same speed.
Therefore, a distribution of speeds must be used that reflect the generalized driving conditions across the State.
For these Guidelines, four speed distributions were developed based on engineering judgment and a relatively
small sample of spot speed data. The four speed distributions include a standard distribution; a freeway
distribution, where drivers tend to drive 5-10 mph over the speed limit; a high-compliance distribution, where
drivers tend to drive closer the posted limit or are limited by geometry such as on a loop ramp; and a low-
compliance distribution, where drivers tend to exceed the speed limit more regularly than normal.
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The default Desired Speed Distributions are established as part of the Road Class definitions and shall not be
modified. In specialized cases it may be acceptable to refine the Desired Speed Distributions based on either field
collected data or historical INRIX data; however, approval of this approach will be on a project by project basis
and must be approved by the NCDOT Congestion Management Section.

The use of the Local Segment/Link Parameters Desired Speed Adjustment or Speed Limit signs shall not be utilized
in coding the model unless approved by the NCDOT Congestion Management Section.

Lane Width

It has been observed and well-documented that drivers tend to reduce their speed in narrow lanes. In other
words, as lateral clearance diminishes, so does a driver's willingness to travel at higher speeds that would
otherwise be acceptable. The coding of lane widths in TransModeler shall utilize the default width of 12 feet for
all lanes being coded. On a project by project basis, it may be determined that the additional effort associated
with coding lane widths is critical to adequately evaluate the operations and requires approval from the NCDOT
Congestion Management Section. If it is determined that lane widths will be modeled, then the lane widths
(rounded to the nearest foot) will be coded for all roadways within the model according to their actual width. If
the lane widths are modeled, there is no effect on operations in TransModeler for lanes coded as greater than 10
feet; therefore, widths greater than 12 feet should only be modeled as 12-foot lanes.

Grades and Elevations
The grade of a roadway has a direct impact on a vehicle’s ability to accelerate and decelerate and is accounted for
in the model. The effect of grades and the modeling of elevations needs to be balanced against the level of effort
required to add them to the model. Three potential options are available and should be determined on a project
by project basis:

e Level 1: No Modeling of Grades and Elevations — Due to minimal variations in topography or the level of
analysis being completed, it is not critical to model the effect of grades on the operations. Therefore, the
model shall be developed with an elevation and grade of zero for all segments and links.

e Level 2: Modeling of Grades Only — The model shall be developed to include the approximate grade, taken
from an appropriate data source, for each segment within the model; however, it shall not include the
development of a full three-dimensional model that includes elevations for each shape point within the
model.

e Level 3: Modeling of Grades and Elevations — The model shall be developed to include the elevations for
each shape point in the model, based on overlaying the model onto a grid derived from LIDAR data. The
elevation data shall be reviewed and modified, as needed, to reflect the true elevation of the roadway as
the LIDAR data set removes bridges and major structures from the elevation grid. The elevation data shall
be set to automatically develop the grades for each segment within the model.

It is also possible that the level of detail for coding grades and elevations in the model may vary between the
existing model data and the proposed design depending on the level of design and shall be determined on a case
by case basis during the scoping of the simulation.

If Level 2 or Level 3 is determined to be the most appropriate level of detail for the model, the profile for each link
shall be reviewed and links shall be split to reflect any changes in grade that are likely to affect the acceleration
and deceleration of vehicles to a level that would affect operations. The model should also be reviewed for
unfeasible grade changes.
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General Link Coding Best Practices
The model should be developed in a manner that allows for the traffic to be simulated in the most realistic fashion
possible. In order to facilitate the development of Measures of Effectiveness, improve the optimization of corridor
operations and enhance the driver behavior within the model, the following are best practices that should be
utilized to the greatest extent possible when coding models.

The use of segment breaks should be somewhat minimized, if possible, as vehicles are not allowed to change lanes
while they are traveling on a lane connector, causing slight disruptions in the driver behavior model. Any locations
with short segment lengths should receive additional review of the vertical elements as there is a tendency to
create short, steep grades, especially if they are modified after they are applied to LIDAR grid data. The use of
node breaks should be greatly minimized and should only be added to the model where absolutely necessary,
especially in close proximity to intersections where Measures of Effectiveness are being collected. Any nodes that
are close to intersections should receive additional review of their associated Superlinks to ensure that they are
collecting output data that is reflective of the overall operations of the intersection.

When developing arterial corridors, maximizing the use of two-way links is highly recommended as it allows for
the development of two-way corridor optimization. Therefore, every effort should be made to code arterials as
two-way links, unless there are compelling reasons to model them as one-way links. Many of the previously
developed models may include parallel one-way links along arterial corridors and do not require re-coding despite
this recommendation.

The length of lane connectors should be minimized to the greatest extent; however, they should still allow for the
smooth flow of traffic within the simulation. While there are no firm requirements, it is recommended that lane
connectors connecting segments with the same number of lanes be about five feet in length, while those
connecting an unequal number of lanes (lane drop/lane add) be approximately 25 feet in length, with slightly
longer lengths (up to 40 feet) on freeways. Again, many of the previously developed models utilized longer lane
connector lengths and may be left alone or revised at the discretion of the analyst and should be determined
during scoping.

The coding of links with tapers on each end of the links results in the link being shown visually without the tapers
and with the full width without the tapering. This does not affect the operations of the model; however, if there
is a desire to have the model appear visually with the tapers on each side then a segment break can be added at
an appropriate location along the link to visually display the tapers on each end of the link.

Freeway Coding Best Practices
The coding of freeway facilities should be done in a manner that is consistent from project to project, unless there
is compelling evidence that the operations in the field differ from the standard method that freeways are coded
in the model. The primary areas where guidance is provided on the best practices for coding freeway elements
are freeway merge, diverge and weaving segments and where acceleration and deceleration lanes begin and end.

For existing conditions where an aerial background is being utilized, the merge point (or start of a weaving
segment) for an on-ramp should be coded such that the combined link begins where the pavement marking on
the ramp first intersects the pavement marking on the through lane of the freeway. The diverge point (or the end
of a weaving segment) for an off ramp should be coded such that the combined link ends at the location where
the pavement marking on the ramp splits from the pavement marking of the through lane of the freeway.
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Sample of Freeway Merge Coding — Existing Conditions

For proposed designs, a similar approach should be utilized; however, the use of long spirals in roadway design
makes the process slightly more difficult. Typically, ramps and loops are 16-20 wide with the alignment being
drawn 12-feet from the outside edge of pavement. Therefore, at merge locations (or the start of a weaving
segment) for proposed designs, the combined link should begin at the point where the full width of the approach
ramp (or loop) would intersect the edge of pavement for the mainline through lanes on the freeway. Similarly,
the diverge (or end of freeway weave segment) for the proposed design should end at the point where the full
width of the departing ramp (or loop) would intersect the edge of pavement for the mainline.

Sample of Freeway Merge Coding — Proposed Design

Segment Begins ; Segment Begins
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The coding of acceleration and deceleration lanes should replicate the geometry and traffic movement of the
entering and exiting traffic. For diverge segments with parallel exits, a lane should be added parallel to the
freeway that allows traffic to move into the lane prior to exiting the freeway. For angular exits, the model should
be coded without any lanes added to the freeway mainline and traffic exiting directly from the outside freeway
lane. The segment break for the deceleration lane for parallel exits should begin at the point where the
deceleration lane reaches approximately eight feet in width with the remaining distance upstream coded as a
taper. Similarly, for an acceleration lane, the segment with the acceleration lane should end at the point where
the lane has tapered down to approximately eight feet in width, with the remaining distance coded as a taper.

For freeway merges in urban areas with higher freeway volumes and greater congestion, it has been observed
that drivers tend to merge sooner than those in rural areas, where congestion is lower. To better model this, the
Lane Connector Connectivity Bias for the lane connector that is merging into the freeway segment should be
modeled with a value of 0.6 for freeway merges on projects located within the boundaries of an MPO and with a
value of 1.0 (the default value) for all other instances. The modification of the Lane Connector Connectivity Bias
to 0.6 may also be used for merges/lane drops on ramp roadways within an interchange if the interchange is
located within the boundaries of an MPO.

Two-Way Left Turn Lane Coding
TransModeler has the ability to model two-way left turn lanes (TWLTL); however, unless the project is modeling
a substantial number of the access points along the roadway with the TWLTL, they should not be included in the
model.

The modeling of left turn lanes along facilities with TWLTLs should be reviewed in close detail and the left turn
lanes may be extended to allow additional storage along the portion of the roadway that is striped as a TWLTL. A
left turn lane may be extended if the likelihood of the left turning traffic on the subject lane encountering a vehicle
desiring to make a left turn in the opposite direction is low in the opinion of the analyst. Left turn lanes should
not be extended beyond any access points along the same direction of the roadway that are estimated to produce
more than 30 entering or exiting vehicles in either peak hour.

Intersection Coding

Intersection Coding Best Practices
The coding of intersections in a consistent manner is a goal that will allow for the most reliable comparison of
alternatives and allow for the re-use of model networks. The following sections include best practices that should
be adhered to as much as possible when developing intersections within the model.
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When coding intersections, lane connectors for each movement should be coded to connect to all receiving lanes
that are likely to be utilized under real world conditions. For example, an exclusive left turn lane from a side street
onto a six-lane arterial should include lane connectors from the left turn lane to all three of the through lanes
along the arterial.

When coding intersections, the coding of turn lanes should generally match the existing geometry and paint
striping, including the addition of a lane prohibition (shown as a solid white line) between the through lanes and
the turn lane. Because the NCDOT default compliance rate for the lane prohibitions is set to zero, the coding is
essentially aesthetic and does not affect the simulation of traffic. Therefore, the coding of the intersection does
not need to include segment breaks where the paint striping changes from solid to dashed. Note that many of
the models developed prior to September 2016 did not include the solid white line lane prohibitions and may be
left alone or revised at the discretion of the analyst and should be determined during scoping.

In TransModeler, vehicles are not able to change lanes while on a lane connector; therefore, the geometry should
be developed in a manner that minimizes the length of lane connectors through an intersection while still
maintaining the operating features of the intersection. Care should be given on the outbound roadways at
intersections to code the location where the exiting segment begins to allow for a reasonable radius for right
turning traffic from the adjacent leg while not extending the lane connectors substantially past the intersection.

When coding intersections, an attempt should be made to remove any crossing vehicle paths - where movements
are occurring at the same time (for example, opposing left-turns that run during concurrent phases). If two
movements with crossing connectors are occurring during the same phase at a signalized intersection, the vehicles
will be shown crossing one another in the simulation. While this does not affect the results of the simulation
substantially, the goal is to make it as aesthetically accurate as possible while still maintaining the proper
operations. The Drag Bend Points tool may be used to modify the path of lane connectors to remove crossing
paths. Additionally, slight changes in the angle of the approach link, especially very close to the intersection, can
change the connector paths to eliminate the crossing connectors. Due to limitations in how intersections are
coded in the model, (including guidance below for offset and channelized movements) it is allowable to have
crossing connectors, but reasonable attempts to remove the conflicting connectors should be made by the
analyst.

Care should be taken in the modeling process to minimize the use of additional nodes in close proximity to other
intersections as this may affect the model outputs if the Superlinks are not properly defined. Prior to running the
model, the network should be reviewed to determine that the Superlinks are properly set for any links with short
length, especially those in close proximity to other intersections.

Lane Connector Connectivity Bias
Modification of the Lane Connector Connectivity Bias allows for the analyst to influence the lane utilization of
lanes at intersections. The driver behavior models in TransModeler account for the dynamics that affect lane
utilization at intersections; therefore, the modification of the Lane Connector Connectivity Bias at intersections
shall not be done without approval by the NCDOT Congestion Management Section.

Modeling Stop Bars and Yield Points
For the modeling of existing intersections that have stop bars that are staggered along an approach, the end of
the link should be coded at the stop bar that is located furthest from the center of the intersection. The Drag Stop
Bar tool should then be used to move the stop bars forward to the location of the stop bar for each lane that
extends beyond the end of the link. However, for signalized intersections, if the difference between the stop bars
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exceeds 15 feet then only place the end of the link 15 feet from the stop bar for the through movements as we
want to avoid vehicles stopping between the end of the link and stop bar that are not triggering the detector.

The vyield points for permitted movements with conflicting traffic should be reviewed in the model for each
intersection and adjusted using the Drag Yield Position tool such that the vehicles yield at an appropriate location
when waiting for an adequate gap.

Modeling Channelized Movements and Offset Turn Lanes

The modeling of channelized movements that are separated (with either painted or physical islands) require
special attention from a modeling standpoint. Channelized right turn lanes shall be modeled as part of the same
link as the through traffic and included in the main intersection node unless there is a lane addition on the
receiving approach. This requirement includes yield controlled movements that do not result in a lane addition
downstream. The Highway Capacity Manual 2010 does not include any means of determining delay or Level of
Service for yield movements; therefore, yield controlled right turn movements shall be included in the signal
operations. Foryield controlled movements, Right Turn on Red (RTOR) may be used for the right turns to emulate
the yield controlled conditions.

The modeling of offset left turns (those with the left turn separated from the adjacent through lanes to improve
sight distance at the intersection) should be treated in a similar manner and modeled as part of the same link as
the adjacent through lanes. If the offset left turn is more than 16 feet away from the nearest through lane, then
the analyst may choose to create a separate link for the left turn lane, if they feel it will produce more realistic
operations.

Coding of Turn Bays and Lane Additions
When coding turn lanes, the available storage is often a critical component of the analysis and should be modeled
at a level that allows for the accurate analysis of the operations. When a lane is added or dropped, it should be
coded such that the link (or segment) begins/ends where the lane reaches approximately eight feet in width with
the remainder length being coded as a taper. The eight-foot width was selected as it is approximately the width
of a car plus a small amount of lateral clearance and is assumed to be the point where two vehicles can safely pass
each other or queue without interfering with one another laterally.

The use of tapers in TransModeler allows for the model to visually match the actual geometry; however, tapers in
TransModeler are aesthetic in nature. While a taper may show an increased width as a lane is added or dropped,
vehicles do not utilize the additional lane width within the taper and only one vehicle can occupy a position
laterally along its length. Therefore, the use of long tapers should be avoided when possible as they do not provide
any additional storage or ability for traffic to pass queued vehicles. The model should be developed to include
the effective length of the storage on each approach and adding lanes one at a time to model transitions is
desirable.

TransModeler does not draw tapers when lanes are added to the median side of the link or segment; therefore,
no additional coding is required and the lane connectors at the lane addition should not be lengthened
substantially to try to give the appearance of a taper.

Modeling Wide Medians and Two-Stage Crossing
The modeling of wide medians and two-stage crossings at unsignalized intersections can have a noticeable effect
on operations and require special consideration when coding the model. If the model is coded with a two-stage
crossing but the median width is not wide enough to store a truck, the truck will block through traffic until it finds
a gap. Conversely, if it is coded as a single node then vehicles must find gaps in both directions of traffic before
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making the turn, causing the side street delay to be much higher than expected. Therefore, a balance is required
to allow the model to produce realistic results.

If a roadway has a median width greater than 50 feet it should be modeled as a two-stage crossing with nodes
being located on each side of the median and a separate link representing the median refuge area between them.
If the median width is 24-50 feet in width the intersection should be coded in the same manner; however, the
intersections should be coded with a minimum link length of 48 feet by moving the intersection nodes out slightly
to accommodate truck storage within the median link. For median widths less than 24 feet, it should be coded as
a single intersection node and vehicles must clear both directions of traffic in a single movement to make a left
turn.

Modeling Crosswalks
The modeling of pedestrians at intersections can have a substantial effect on the operation of the model and may
be included in the analysis on a project by project basis. If it is determined that crosswalks will be included in the
model, they should be added to the network with the Add Crosswalk Tool in the Roadway Editor toolbox. Once
the crosswalks are added, the end of the link (and any stop bars) should be modified such that they are prior to
the crosswalk.

The modeling of pedestrians requires the creation of a pedestrian volume file (.ped) on the Input tab of the Project
Settings. The pedestrian volumes should be added to the model using the Edit Pedestrian Volume tool included
in the Edit Intersection toolbox. Unless there is a compelling reason approved by NCDOT not to, pedestrian
volumes should be included with random arrivals.

Turn Prohibitions
The model being developed shall include all turn prohibitions. If a single movement is prohibited, then the
prohibition shall be coded by not providing a lane connector for the prohibited movement. If the prohibition is a
series of movements, such as no through traffic through a shopping center, the prohibition should be coded
utilizing the Turn Prohibition Editor with the turn prohibition file (.bin) being added on the Input tab of the Project
Settings.

Any turn prohibitions in the model shall be detailed in documentation for the model with the justification for the
prohibition.

Signalized Intersection Coding

The coding of signalized intersections in TransModeler requires a basic understanding of signal design and
operations. Attempts have been made to simplify the coding of signalized intersections and the following section
includes the default values and basic coding requirements for signalized intersections. More detailed coding of
signalized intersections may be allowable on a project by project basis if they are warranted by the project scope
or the nature of the improvement. Deviation from the default values shall be discussed with the NCDOT
Congestion Management Section and documented in the model documentation, if approved. For additional
guidance on the design of signalized intersections, please refer to the NCDOT Traffic Management and Signal
System Unit Design Manual
(https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit
%20design%20manual.pdf).

The coding of signalized intersections is completed by utilizing the Edit Intersection Control tool in the Intersection
toolbox. The following sections include the process for coding signalized intersections in the model.
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Control Type and Configuration
All signalized intersections in TransModeler shall be coded as Traffic Actuated signals and the Actuated Controller
Configuration shall be Type 170. The main approach that includes phases 2+5 should be selected based on which
roadway is the major roadway and is typically either the Eastbound direction if the East-West route is the major
roadway or Northbound if the North-South route is the major roadway.

Time of Day Plans
The signal input file (.tms) should include timing plans for each simulation period within a given scenario being
modeled. The use of separate AM and PM input files is strongly discouraged. The Start Time field shall be set such
that it begins either before or at the same time as the simulation project being modeled. Typically, there should
be a separate signal timing plan for each peak period being modeled. The signal input file is loaded in the Project
Settings Input tab.

Turns Tab
The turns tab shall be populated (through the use of a turning movement .bin file) for any projects that include
isolated (non-coordinated signals) as they rely on the turn data for optimization. A single .bin file is preferable
that includes individual fields for each period being simulated.

Timing Tab
The timing tab is where the signal phasing and timing parameters are entered for each signal. For any existing
signals, the use of the Table of Operations and Phasing Diagram on the existing signal design plans should be
utilized as a basis for determining the phasing for the signal. In the absence of an existing signal plan, engineering
judgment or the technique described in the Developing Phasing and Timing for New or Modified Signals section
below should be utilized to determine the most appropriate phase settings.

The phase ID’s shall be set based on the NEMA phase numbering system included in the following figure.

Standard NEMA Orientation
Dual Ring Cabinet
Major Street runs East-West
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Phase Numbering

Phase 2 - Eastbound through movement

Phase 4 - Southbound through movement

Phase 6 - Westbound through movement

Phase 8 - Northbound through movement

Pair turning movements with the through movements
if an exclusive left turn phase (protected or
protected/permissive) is not used.

If location is being added to an existing system,
match phase numbering to the system.
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If location is being added to an existing system,
match phase numbering to the system.
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The phase settings for each of the phase ID’s shall be defined in the Intersection Control Editor Map View Pane.
The movements in the Map View Pane should be set to correct states by right clicking on the arrows to properly
define the green movements as permitted, protected or overlap. The operations of protected and overlap right
turns are identical in the simulation of the model; however, are accounted for differently when calculating the
deterministic Highway Capacity Manual (HCM) based delay. Therefore, overlaps shall be categorized correctly
when utilizing deterministic Level of Service measures of effectiveness.

Right Turn on Red (RTOR)
Right Turn on Red (RTOR) shall not be included in the model for modeling of signalized intersections in a future
year analysis, except where explicitly allowed (see below). Because RTOR are not allowed for the future year, they
should also not be modeled as part of the base year scenario in order to allow for a more reliable comparison of
the results.

The use of RTOR is permitted when coding channelized right turns with yield controlled movements that are being
modeled as part of the signal (see Modeling Channelized Movements and Offset Turn Lanes section for additional
details). On a project by project basis the use of RTOR for signals that currently allow RTOR and are not modified
as part of the build improvements may be allowed, if approved by the NCDOT Congestion Management Section.

Flashing Yellow Arrow

TransModeler includes the ability to model Flashing Yellow phases; however, the application of the Flashing
Yellow Arrow does not appear to fully replicate the true operations of the phasing technique and is more geared
towards the use of overnight flash than as a means of controlling permitted left-turns. Therefore, the phasing
should not include flashing yellow for left turns; any left turn movements that include flashing yellow should be
modeled as permitted green movements. If the left turn movement controlled by a flashing yellow arrow is a
permitted only (not protected/permitted), the permitted green may be added to the corresponding through phase
on the opposite side of the intersection. For example, a westbound permitted left would typically be included in
Phase 6 (if the east-west route is the major street); however, it could also be added to Phase 2. This would allow
the permitted left to begin before the through movement on the same approach as is allowed for Flashing Yellow
Arrow operations.

One of the primary advantages of the Flashing Yellow Arrow is that it eliminates the “yellow trap” where drivers
may make a left turn movement as their signal turn transitions to red assuming the opposite direction is
transitioning to red at the same time. Because of the way TransModeler operates, the unsafe driving behavior
that is exhibited with the yellow trap does not occur; therefore, the use of the permitted green phasing will
adequately address the yellow trap concerns in the modeling of the signal operations.

Timing Settings
The default timing settings in TransModeler are defined in the NCDOT Default Simulation Project file and are
described, along with guidance on how each parameter should be implemented beyond the default setting, in the
following section.

e Coordinate Beginning of
o Default = Green
e Min Green
o Default =7 seconds
o Modify through movement phases that carry a majority of the traffic on each approach (where
the through movement is higher than the sum of the left-turn, right-turn and u-turn movements)
based on the posted speed along the approach, with 50-55 mph = 14 seconds, 40-45 mph = 12
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seconds and £35 mph = 10 seconds. If a movement meets the criteria for either peak period, both
periods shall include the revised minimum green.
Maximum Green
o Default = 60 seconds
o Should be modified to fit the actual needs of each phase within the intersection
Yellow
o Default =5 seconds
Red Clearance
o Default = 2 seconds
Lost Time
o Default =5 seconds
o Doesn’t affect simulation, but does affect deterministic LOS results
Recall Mode
o Default =none
o Min recall for minor street through movement phases if a majority of the traffic on the approach
makes the through movement
o Max recall for major street through movements
Memory Mode
o Default = Non-Locking
Extension
o Default = 3 seconds
o Moadify for through movement phases that carry a majority of the traffic on each approach to 6
seconds
Simultaneous Gap Out
o Default =Yes
Added Initial/Actuation
o Default = 2 seconds
Max Initial
o Default =30 seconds
Time before reduction
o Default = 15 seconds
Reduce by / Every
o Default =0.5 seconds / 5 seconds
Min Gap
o Default = 3 seconds
Coordinated Phases
o Default = No
o Shall be modified to yes for any coordinated phases, typically phases 2+6
Max Inhibit
o Default = No
o May be modified to Yes for select phases if properly documented in model documentation
Optimization Minimum Green
o Default =7 seconds
o Modify to match Min Green settings defined above
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Detector Placement and Settings
The use of detectors, or loops, for signalized, actuated intersections is vital to properly modeling a signal’s
operations. To simplify the process of developing detectors in TransModeler a default detectors template is
included in the NCDOT Default Simulation Project file, and is located in the Intersection Toolbox Configuration
dialog box.

Intersection Toolbox Configuration L-ghj
Detector Defaults
STOPBAR DETECTOR
Exclusive Left Through/Shared Exclusive Right
Detection Call + Extend Call + Extend Call + Extend
Mode Presence Presence Presence
Setback Distance (ft) 0.0 0.0 0.0
Length (ft) 40.0 40.0 40.0
ADVAMCE DETECTOR
Exclusive Left Through/Shared Exclusive Right
Detection None Call + Extend Mone
Maode Presence
Setback Distance (ft) 3000
Length (ft) 6.0
[ OK l [ Cancel ]

h

The default detector setup for NCDOT signals includes the following:

e Minor Street Approach (Phases 4+8) — Stop bar detection on all lanes and no advance detection
e Major Street Approach (Phases 2+6) — Advance detection on through and shared lanes with stop bar
detection for exclusive right and left turn lanes

The default settings for the detectors include the following:

e Detection set to Call and Extend for all detectors
e Mode set to Presence for all detectors

e Stop bar detector length = 40 feet

e Advance detector length = 6 feet

e Setback distance for Advance detectors = 300 feet

Detectors are added as Sensors in TransModeler by utilizing the Add and Assign Detectors tool on the Intersection
toolbox. Once the sensors are added based on the above default template, the analyst should remove (using the
“Delete a Sensor Station” tool on the Roadway Editor toolbox) the following detectors:

e Major street (phases 2+6) through and shared through and right 6-foot by 40-foot sensors at the stop bar.
e Minor street (phases 4+8) through and shared through and right/left 6-foot by 6-foot sensors located 300
feet upstream of stop bar.

On a project-by-project basis, the analyst may utilize advanced detector settings if approved by NCDOT, with all
changes included in the model documentation, including:
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e Utilizing the actual detector settings from a signal design plan (typically only for advanced simulations
requiring calibration)

e Modifying the Setback Distance based on approach speed limit

e Adding delay settings to stop bar detectors

e Adding queue or carryover settings for advance detectors

e Modifying default detector assignment for overlap phases

e Modifying the Setback Distance when the link is shorter than 300’ (tight diamonds, etc.)

Pedestrian Timing Settings
If it is determined during scoping that the model will include the analysis of pedestrians at intersections, then the
following settings shall be utilized:

e Pedestrian Links shall be defined in the Map View Pane where a crosswalk will be added and the link
defined in the Ped Links field in the Timings tab
e Pedestrian Walk + Flashing Don’t Walk (W + FDW) shall be defined as:
o W+ FDW =7 seconds + Crossing Width (ft) / 3.5 ft/sec

Ring and Barrier Tab
Once the phases for a traffic-actuated timing plan have been defined, a phase order and transition scheme with a
ring-and-barrier table can be defined as well. The ring-and-barrier table is a common method for illustrating the
phase transition logic for actuated controllers. The ring and barrier tab is where the phase order and transitions
are defined in TransModeler.

The block of phases between any two consecutive barriers is referred to as a barrier and the sequence of phases
in a single row — which may span multiple barriers —is referred to as a ring. Dual ring, two-barrier designs are
common. However, TransModeler allows more complex designs with as many as 8 barriers and 8 rings.

The ring and barrier for existing signals should be defined based on the Phase Diagram from the existing signal
design plan. For modified or new signals, the ring and barrier table should be set up based on engineering
judgment and the best practices described in the Signalized Intersection Coding Best Practices.

HCM Adjustments and LOS Tab

TransModeler has the ability to analyze the Level of Service for intersections based on the deterministic LOS
methodologies from the Highway Capacity Manual 2010 (HCM 2010). The use of deterministic LOS may be
approved by the NCDOT Congestion Management Section on a project by project basis for intersections that have
relatively low volumes and congestion is not a major concern of the project. In order to fully implement the HCM
methodology, several variables should be input on the HCM Adjustment tab based on the guidelines included in
the NCDOT Congestion Management Section Capacity Analysis Guidelines
(https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Signing/Congestion%20Manage
ment/Capacity%20Analysis%20Guidelines.pdf). Once the turn data field is selected the LOS output will be
calculated on the LOS Tab

Run Yellow Threshold Parameter
One of the parameters that is utilized in TransModeler is the Run Yellow Threshold, which determines whether a
vehicle will enter the intersection during a yellow traffic signal indication, provided that the movement through
the intersection is unimpeded. If the expected travel time to reach the stop bar at the intersection is less than
this threshold, a vehicle will proceed to enter the intersection. Otherwise, it will decelerate and prepare to stop
at the stop bar.
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Based on the default timing parameters of 5 seconds yellow and 2 seconds red clearance, a default Run Yellow
Threshold of 4 seconds is included in the default parameters file. This was determined assuming a startup lost
time of 2 seconds for a total of 9 seconds of Yellow, Red Clearance and Startup Loss. The NCDOT default for Lost
Time is 5 seconds; therefore, a run yellow threshold of 4 seconds would allow for this 5 second value.

If actual signal timings are utilized in the simulation, the default Run Yellow Threshold should be set at 80 percent
of the average yellow time based on the timings for all signals in the model.

Signalized Intersection Best Practices
The phasing and timing settings for signalized intersections require the analyst to review the demand volumes
and simulation to determine the most appropriate signal operations. Much of the guidance included in the NCDOT
Congestion Management Section Capacity Analysis Guidelines is directly applicable to simulation based studies,
including:

e Signal phasing should remain consistent for all time periods. As an example, if split phasing is used for the
AM peak, it must be used for the PM peak. Changing the phasing sequence, such as altering left-turn
phasing from leading left to lagging left, is dependent on the traffic signal controller equipment.

e Dual Left Turns should be used cautiously due to:

o Turn Conflicts requiring split phasing

o Protected Phasing (see signal plans)

o Driveways in close proximity to the intersection on the receiving lanes can lead to erratic
movements

o Merges on the receiving lanes can create false capacity in the analysis

e Dual Right Turns with one lane sharing a Through movement perform poorly in overlap and Right-Turn-
On-Red conditions.

e  Through Movements on highway ramps should not be combined with right turns for three phase signals
or standard diamond configurations. The through movement should be shared with the left-turn lanes.

e For analysis of future operations, use protected-only phasing, not protected/permitted phasing. This
analysis will identify the required storage in the event that protected-only phasing is necessary. The use
of protected/permitted phasing for signals not included in the Build design of the project may be allowed
on a case by case basis with approval from the NCDOT Congestion Management Section.

e Intersections with combination through/left-turn lanes should have either permitted-only left-turn
treatment or split phase left-turn treatment for that approach. This is not a recommended geometric
configuration and should be avoided when possible if there is an opposing movement.

e lane configuration for opposing side streets should match when possible to avoid driver confusion (for
example: avoid a combination through/left-turn and right-turn lane on one approach opposite a
combination through-right-turn and left-turn lane on the opposite approach).

e For analysis, generally use protected left-turn treatment instead of permitted when:

o Dual left-turn lanes are present

o Hourly volume exceeds 240 cars

o Left-turn lanes are crossing 3 or more opposing through lanes of traffic
o When a condition is satisfied in the table below:
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Number of Opposing Lanes
(Through and Right) Condition

1 Left-Turn Volume * Opposing Volume > 50,000
2 Left-Turn Volume * Opposing Volume > 90,000
3 or more Left-Turn Volume * Opposing Volume > 110,000

e Use overlapping right-turn phasing where appropriate. Use of a shared through-right turn lane limits the
effectiveness of the right-turn overlap, especially where volumes require dual right turns.

e Cycle lengths for individual intersections in coordinated systems should be equal. Double or half cycles
can be used if the minimum cycle lengths, defined below, are accommodated.

e |t should not be the intent at the planning stage of a project to fully design and optimize a coordinated
traffic signal system.

e Generally, the minimum cycle lengths are shown in the table below. Deviation from these minimum
values is acceptable if justified in the model documentation.

Number of Phases Minimum Cycle Length

2 60 seconds
3-6 90 seconds
7 or more 120 seconds

e Generally, the maximum cycle length should not exceed 180; however, cycle lengths up to 240 seconds
are acceptable if justified in the model documentation.

It is becoming more common, especially with alternative intersection designs, to have a single signal controller
controlling multiple intersections (nodes). TransModeler is able to group multiple nodes into a single signal
controller by using the Edit Intersection Control tool on the Intersection toolbox and while holding down the Shift
key, selecting each node that you want grouped together, and then selecting the green checkmark in the Multiple
Intersections dialog.

Developing Phasing and Timing for New or Modified Signals
As stated above, the initial development of the phasing for a signalized intersection should rely on the existing
signal design plan for the intersection. For intersections that are being modified substantially, or are new
intersections, engineering judgment, in accordance with the above Best Practices should be utilized to develop
the phasing and timing plans. However, if the analyst is uncertain about what the best timing plan may be,
TransModeler has the ability to develop phasing and timing plans from turning movement data based on a set of
default rules and a template from the Ring and Barrier Table.

To allow TransModeler to develop the Timing and Ring and Barrier data, the intersection turning movements shall
be entered on the Turns tab and all of the phases should be deleted from the Timing tab, leaving the Phases table
empty. The Optimization tool on the Timing tab can then be selected with the default information for the Timing
Plan set (as described in the Signal Optimization section below). Three additional tabs are also included for
intersections with no phases defined, including the Phase Sequence, Turn Treatment and Left Turn Rules tabs.
The analyst should review the available Ring and Barrier templates and may experiment with different templates
to determine the best phase sequence for the intersection. On the Turn Treatment Tab, the Left Turn Treatment
can be defined or set to Rule Based with RTOR set to Prohibited. The Left Turn Rules tab provides some rules of
thumb for determining when Permitted or Protected Phasing should be utilized. These rules will provide
reasonable results, but should always be verified against the information provided above in the Best Practices
section. Once the settings are configured, the OK button can be selected and TransModeler will develop a Timing
Plan and Ring and Barrier based on the options selected. The LOS Tab can be utilized to test various phasing plans
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by using different Ring and Barriers Templates and the deterministic LOS to determine the best phasing plan for
the intersection. Note that once the timings are set, additional revisions will be needed on the Timing plan to
match the default settings listed above in the Timing Settings section.

Roundabout Coding
The coding of roundabouts in TransModeler is done by utilizing the Add Roundabout tool in the Road Editor
toolbox. By using the Add Roundabout tool, the roundabout will be coded with the proper road classes to allow
for the network to properly model the driver behavior of traffic at the roundabout. If detailed design data is not
available for roundabouts, single lane roundabouts should have an inscribed diameter of 120 feet and multi-lane
roundabouts should have an inscribed diameter of 150 feet,

Roundabouts shall be coded based on their inscribed diameter with a lane width of 12 feet. Circulatory lane
widths greater than 12 feet shall only be modeled as 12 feet, as the increased lane widths may cause changes in
driver behavior as the maximum speed for a horizontal curve is based on the inside edge of the lane. If the
roundabout is located along a corridor that includes signalized intersections, the links on each approach should
be maintained as two-way links and not separated into one-way links due to the effect it has on signal optimization
along corridors.

Each roundabout should be drawn with a splitter island on each approach. For roundabouts with a median width
less than 16 feet, the width of the splitter island should be 15 feet and the length should be 30 feet. For
roundabouts with a median width of 16 feet or more, the width of the splitter island should be the median width
+ 5 feet, while the length of the splitter island should be twice the width of the splitter island. Based on the median
width of the approach roadways, the length and width may have to be adjusted for each individual approach,
using the Road Editor, if the approach roadways do not have a uniform median width that allows for all approaches
to be created with the Add Roundabout tool.

The driver behavior for roundabout operations is accounted for in the model through the use of the Roundabout
Road Classes; therefore, the addition of yield signs is not needed for the entry lanes to the roundabout. Once the
roundabout is coded, the Road Class for the circulatory roadway shall be reviewed and the appropriate
Roundabout Road Class based on the circulatory speed of the roundabout shall be selected.

The coding of the roundabout, especially for multi-lane roundabouts, should be based on the proposed design
with the lane connectors accurately representing the proposed geometry. For multi-lane roundabouts, because
vehicles cannot change lanes while on a lane connector, care should be given to minimizing the length of lane
connectors within the roundabout to allow for the most realistic operations possible. Lane change prohibitions
should not be used inside the circulatory area of the roundabout unless special circumstances dictate their use.
In this case, their use should be documented.

The coding of bypass lanes at roundabouts can be accomplished several different ways. The preferred method
for coding bypass lanes that do not result in an additional lane being added on the downstream roadway should
be to code the bypass lanes as an additional lane within the roundabout. The preferred method of coding bypass
lanes that add an additional lane on the downstream roadway should be to code them as a separate link outside
of the roundabout with no direct interactions with the roundabout geometry.

The coding of roundabouts in TransModeler also requires a careful review of the network to ensure that the
Superlinks defined are able to accurately collect the delay and queue data at the roundabout approach. Because
the roundabout tool adds a node at the beginning of the splitter island, it creates a short link approaching the
circulatory roadway. The delay and queue data on this short link may not accurately be reflected if there is
substantial queueing on the approach. Therefore, special care should be taken to utilize the Superlink Manager
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to combine Superlinks in a manner that will allow the output to be collected properly. An example of the coding
of a single Superlink between two roundabouts is shown in the following graphic.

Sample of Superlink Coding at a Roundabout

Superstreet Coding

The proper coding of Superstreets in TransModeler allows for the accurate modeling of the operations and
optimization of the corridor with full one-way progression. The preferred method for coding superstreets is to
develop them as one-way links in each direction along a roadway. For most applications of the superstreet
corridor, utilizing one-way links provides for the most accurate evaluation of the operations. Therefore, the coding
of links along the main roadway should be as individual one-way links in each direction with the appropriate
median width. However, if the superstreet intersection is not the primary emphasis of the project and is for an
isolated intersection along a longer corridor with all of the remaining signals being full movement, the analyst may
code it as a two-way link to allow for the two-way optimization of the overall corridor.

The coding of the main intersection should be such that each direction of travel has its own node. If the main
intersection includes directional left turn lanes from the mainline onto the side street, they should be coded as
separate links with the link beginning at the point where the monolithic island would begin. Consideration should
be given to adding a segment break and short additional lane on the mainline link in advance of the left turn lane
splitting from the mainline roadway to better model the transition into the left turn storage bay. If the model
includes movements from the side street directly into u-turn lanes that extend back to the main intersection, the
direct entry u-turn lanes should be coded as part of the main intersection node, but should not have lane
connectors from the mainline through lanes to the direct u-turn lanes. If pedestrians are included in the model,
they shall be modeled with a standard z-crossing.

The coding of the u-turn locations should include creating a short link between each direction of traffic with either
a stop sign or a signal at the node where the vehicles are turning. If a traffic control device is not placed on the u-
turn link, it will not be possible to collect delay or LOS at the node; therefore, all u-turn nodes must have a traffic
control device defined. The stop bar and/or yield point should be adjusted to accurately model the location where
vehicles wait to make the u-turn movement.

Diverging Diamond Interchange Coding
The coding of Diverging Diamond Interchanges (DDI) in TransModeler allows for the detailed evaluation of the
operations of the interchange. The coding of DDIs shall include developing them to a level that incorporates the
design elements that are critical to their operations. The DDI geometry should be coded in TransModeler with
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reverse curvature upstream of the crossover, with crossover angles between 40 and 50 degrees and a tangent
section through the crossovers.

Because DDIs have slightly different Desired Speed Distributions where vehicles tend to adhere more closely to
the speed limit, specific DDI Road Classes have been developed and shall be utilized along with the design speed
for the DDI itself. The DDI-specific Road Class should be utilized for the approach links that have the reverse
curvature and the links within the interchange itself.

The coding of the signals for DDIs shall include the use of two controllers with dummy phases being utilized to not
trap vehicles on the link between the crossover and the adjacent signals that control the turn movements on each
side of the interchange.

In the event that pedestrian crossings are included in the model, care should be given to the location of the
crosswalks and stop bars. Due to the geometry of the DDI, the model frequently includes very long lane
connectors. Because vehicles cannot change lanes while on a lane connector, the distance added due to the
inclusion of crosswalks may result in traffic movements that do not fully replicate the expected operations within
a DDI. If this occurs, consideration of extending the stop bars further into the intersection may be acceptable with
proper documentation in the model documentation and approval from the NCDOT Congestion Management
Section.

The coding of the model and how delay and queue length are extracted as part of the output of MOEs should also
be reviewed. With the DDI configuration, short links are created and proper review of the model to combine links
into Superlinks is critical and allows for the improved accuracy of output data. Additional guidance on Superlinks
is included in the Measures of Effectiveness section.

Check Network and Check Signal Plan
Following the development of the model and prior to running any output or submitting for review, the analyst
should utilize the Check Network and Check Signal Plan tools to review the model coding. The following
evaluations should be included in the Network Check:

e Errorsinintersection geometry

e Short segments (<10 feet)

e Errors in segment geometry (shape, grade and elevation gaps exceeding 8 feet)
e Missing lane connections

e Invalid Superlinks

e Signalized intersections without timing plans

e Detectors not assigned to any phase

e Node and Segment fidelity errors

It is possible, although rare, that the network check will identify items that are not actually errors. Therefore, if
after running the network check, it is determined that items are identified that are not actual errors, they should
be documented in the model documentation.

The Check Signal Plan tool (>Project>Intersection Control>Check Signal Plans) should also be run with any non-
resolved errors noted in the model documentation.

SIGNAL OPTIMIZATION
The optimization of signalized intersections is vital to accurately modeling the traffic operations of both isolated
signals and coordinated corridors. The optimization of signals in TransModeler is completed in two different
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manners depending on the number of signals being analyzed, with isolated signals (those that are not coordinated
with other signals in a signal system) and multi-signal corridors (those that are coordinated as part of a signal
system) being optimized with separate methods.

The following are recommendations for signal timing and apply to all signalized intersections.

e Generally, the minimum cycle length for a two-phase signal should be 60 seconds, with three to six phase
signals having a minimum cycle length of 90 seconds, and seven or more phases having a minimum cycle
length of 120 seconds. Deviation from these minimum values is acceptable if justified in the model
documentation.

e Generally, the maximum cycle length should not exceed 180; however, cycle lengths up to 240 seconds
are acceptable if justified in the model documentation.

e Overall cycle lengths should be rounded to the nearest 10 second increment and individual splits should
be rounded to the nearest whole second.

Isolated Signals
If the signal is an isolated signal (not coordinated with another signal) then the Optimize Signal Timings feature
under the Phase Tab of the Intersection Control Editor shall be utilized. In order to run the optimization process,
the turning movement volumes shall be added to the project settings on the Network Tab. Once the Optimize
Signal Timings tool is selected, the Flow field shall be set to the turning movement volumes for the period that is
being optimized, typically the peak hour. The signal optimization shall be run with Webster Equation selected for
the Optimize Cycle option and the minimum and maximum cycle lengths (as described above) included. The
optimization should be run with the Optimize Split option set to Rule-Based. If optimization of the leading and
lagging phases is appropriate, then the Optimize Phase Sequence option under Phase Sequence may be selected.

If the optimized cycle length is not an even 10-second increment, then round to the nearest 10 second increment
and re-run the optimization with the rounded value as the fixed cycle lengths. Once the cycle length is an even
10-second increment, each phase split should be adjusted to the nearest second with the overall cycle length
being maintained.

Multi-Signal Corridors

For projects with multiple signalized intersections that are located along a corridor, the simulation-based signal
optimization tool in TransModeler shall be utilized. The signal optimization process utilizes the Corridor Toolbox
(>Project>Intersection Control>Corridor Toolbox). Before initiating the signal optimization process, all Superlinks
along the corridor shall be reviewed to ensure they are accurately collecting the delay and queue data along the
corridor. The first step in the optimization process is to select the corridor to be optimized by developing a path
beginning at least one node upstream of the first signal being optimized and ending at least one node beyond the
last signal in the corridor. For corridors with only two-way links, it is not important which direction is selected.
However, if there are any one-way links along the corridor it can only be optimized in one direction; therefore,
the peak direction with the highest volumes should be optimized for each period being optimized.

Once the multi-signal corridor is selected, the optimization shall be completed by setting a warmup period of at
least 5 minutes (increase to 10 minutes if any major route in the network exceeds 3 miles) and evaluation start
and finish times of 8:20-8:50 for the AM peak and 17:20-17:50 for the PM peak. The Optimize Signal Timings
setting shall be set to Both Directions if all links along the corridor being optimized are two-way links and to One
Direction if any of the links along the corridor are one-way links.
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The cycle length should be optimized with the minimum and maximum cycle lengths (as described above) and
Step being set to 10 seconds. Under the options tab, the Master Intersection (Offset =0) shall be set with the
Number of Simultaneous Simulations typically being set to Max to minimize run times.

The default weighting in TransModeler tends to produce shorter cycle lengths; however, the trend in North
Carolina tends to be towards longer cycle lengths. Therefore, the Performance Index MOE weighting should be
set to the following to allow the optimization to trend toward higher cycle lengths:

e Control delay=1

e Queue Length=0.5
e Arrival on Green=5
e Stops=0.25

The weighting may be reviewed on a project-by-project basis and modified if the cycle lengths being produced are
not reasonable; however, all scenarios that are being compared shall utilize the same Performance Index MOE
Weights.

The default settings for Offset optimization should also be utilized

e Stagel

o Step Size=5 seconds

o Number of Steps=6

o Number of Iterations=3
e Stagell

o Step Size=1 second

o Number of Steps=5

o Number of lterations=6).

The optimized cycle length shall be rounded to the nearest 10 second increment and phase splits should be
rounded to the nearest 1 second.

Best Practices for Signal Optimization

The optimization of signalized intersections requires experience in traffic operations and basic knowledge of signal
design; however, the optimization methods in TransModeler should be considered a tool that assists the analyst
in developing the signal timing and offsets for a given project. Therefore, fine tuning of the signal optimization is
recommended following the completion of the optimization task in TransModeler. The simulation should be
reviewed and the operations observed to determine how well the signals are operating. Utilizing the Create Time
Space Diagram tool from the Corridor toolbox is also a valuable tool in determining how well a corridor is
optimized. Once the overall network has been reviewed, the analyst may attempt to improve the overall
operations by fine tuning the phasing, timings or offsets, with all changes being reviewed by simulating the model.
Any substantive modifications to the optimized signal phasing, timings or offsets should be described in the model
documentation.

The integration of either half-cycles or double-cycles for individual signals along a coordinated corridor is also
acceptable; however, these options are not available in the standard optimization procedures. Therefore, an
analyst may choose to utilize half- or double-cycles along a corridor and should optimize their operations through
the use of the Time-Space Diagram and through observation of the model simulation.
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TransModeler does allow for the coordination of individual paths that support major movements, even if they are
not along a defined corridor. The use of the Corridor Optimization for non-linear paths and the utilization of Time-
Space diagrams may be utilized if there are major travel patterns that require coordination that are not along a
linear corridor.

The coordination of grids and other networks where major corridors intersect may include optimizing both the
east-west and north-south routes at the same time, which is possible in TransModeler. The best way to coordinate
this type of system is to first optimize the major route that includes the coordinated phases, then each
perpendicular route should be reviewed and the cycle length set to the same (or a compatible variation of the)
major corridor cycle length with each signal’s splits being optimized individually. Then, the Time Space Diagram
for the minor roadway corridor should be selected and the green band for the major intersection should be held
constant with the green bands for the other intersections being moved to manually optimize the coordination
along the perpendicular route while not affecting the coordination on the major roadway.

Optimization of Superstreet corridors should be done individually for each direction of travel along the corridor.

VOLUME INPUT

The development and input of traffic demand is one of the most important elements of a simulation project.
Defining traffic demand in TransModeler includes not only the volumes of vehicle trips to be simulated, but also
the paths vehicles choose to travel to reach their assigned destination. Traffic demand can be specified through a
variety of methods, such as defining turning movements, origin-destination trip tables, or a specific set of vehicle
paths. These Guidelines will provide standards for utilizing either Turning Movement Counts (TMC) or Origin-
Destination (O-D) Matrices.

This version of the Guidelines presents the settings and input parameters required to simulate volumes in the
model. Additional research is being developed to determine the best practices for developing volumes and to
provide guidance on which of the two methods should be used. In general, smaller projects should not have any
problem with utilizing TMC data, while larger projects are typically developed utilizing O-D matrices. Additional
guidance on selecting the appropriate type and the actual procedure for converting peak hour volume data to O-
D matrices will be included in future versions of these Guidelines.

One item that needs to be determined during the scoping process for each project is whether or not the volume
data will be balanced prior to being utilized in TransModeler. Both the TMC input and the O-D matrix process can
accommodate unbalanced trips within the volume development stage. If TMC counts are being utilized and the
volumes are to remain unbalanced, TransModeler will automatically balance the network through the use of
sources and sinks along the internal links of the model. If O-D matrices are being utilized, the O-D development
process will result in balanced trips as all vehicles have a defined origin and destination. If it is determined during
scoping that the network volumes will be balanced prior to being added to TransModeler as TMC data or if the
network will be balanced prior to the O-D matrix development process, the method utilized for balancing shall be
included in the model documentation.

Warm-up Period
Each simulation shall include a warm-up period prior to outputs being collected that allows the network to have
background traffic in the network when the analysis period begins. The Warm-up Period shall be determined to
be the greater of either 15 minutes or the expected travel time for the longest path within the model, rounded
up to the nearest five minutes. The warm-up volumes should be scaled to 70 percent of the peak hour volume
being modeled for projects located outside the boundaries of an MPO and 85 percent of the peak hour volume
for projects located within the boundaries of an MPO. Deviation from the default percentage may be allowed on
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a project-by-project basis by the NCDOT Congestion Management Section if actual count data demonstrates that
a different percentage would produce more reasonable results. Any deviation from the default shall be included
in the model documentation.

Turning Movement Count Input
Utilizing TMC data as a volume input requires that the volumes be added to the TMC input file (.bin file) for each
intersection or node (such as a freeway merge or diverge) where there is a change in volume. The NCDOT Default
Simulation Project file includes a TMC file with the following volume fields:

e TMC_0745 - AM Warm-up Volumes
e TMC_0800 - AM Peak Hour Volumes
e TMC_1645 - PM Warm-up Volumes
e TMC_1700 - PM Peak Hour Volumes

The TMC_0745 and TMC_1645 fields shall include volumes that are 75 percent (or other approved percentage) of
the corresponding peak hour volume and should be entered as an hourly rate (not factored down to 15-minute
volumes). The TMC_0800 and TMC_1700 fields shall include the peak hour volumes entered as hourly rates for
all nodes within the model.

The TMC file (.bin file) shall then be added to the Trip Tables section of the Project Settings Input Tab
(>Project>Settings>Input tab). The Turning Movement Table Settings should then be set to the following by
selecting the Trip Table Setting icon on the Input Tab:

Field
Contains:

AM Peak

Value
Multiple Period Volumes

Field
Contains:

PM Peak

Value
Multiple Period Volumes

First Volume Field

TMC_0745

First Volume Field

TMC_1645

Num. Periods 2 Num. Periods 2
Start Time 07:00:00 Start Time 16:00:00
Interval 60 minutes Interval 60 minutes

Turning Movement Table Options

External Link Imbalance Threshold 0 vph

Scaling Factor 1.00

Internal Link Sources and Sinks — Imbalance Thresholds 20 vph

Internal Link Sources and Sinks — Source Start/End Position 50 % / 50%
Internal Link Sources and Sinks — Sink Start/End Position 50 % / 50%
Departure Headway Distribution Random (Uniform)

Once the Trip Tables are set up, the Local Loading Parameters need to be modified to allow for the loading of the
volumes based on a distribution that emulates a Peak Hour Factor (PHF) of 0.90. The NCDOT Default Simulation
Project file includes the NCDOT_TMC distribution for the Trip Departure Time Distributions and shall be utilized
for projects that include the simulation of TMC volumes. Therefore, the NCDOT_TMC distribution shall be added
to the Node data layer for all external nodes within the model. Note that the Utilization of the Trip Departure
Time Distributions requires utilizing TransModeler 4.0 Build 6125 or later.

Origin-Destination Matrix Input

Utilizing O-D matrices in TransModeler includes loading each trip via an external origin node or centroid and
assigning it to exit the model at a defined external destination node or centroid. For each scenario being modeled,
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two matrices are required; one for the warm-up period, and one for the peak period being modeled. Both the
warm-up and peak hour matrices should include the same volumes with the reduced volume during the warm-up
period being implemented through the use of a scaling factor in the matrix settings.

O-D matrices are created using the Create Trip Matrix dialog box (>Demand>0-D Matrix>Create Trip Matrix) and
selecting the Origins and Destinations fields. Typically, the Origins and Destinations are set to All Boundary Nodes
(or All Centroids); however, the use of a selection set of nodes or centroids may also be utilized.

Each matrix that is to be utilized during each scenario is added to the Project Settings on the Input tab under the
Trip Tables section.

Once the matrix is created, the matrix settings must be defined. The following sections describe each Tab on the
Trip Matrix Settings dialog box.

Setup Tab

The setup tab includes the basic parameters describing the O-D matrix, including the time period of the day to
which the O-D matrix applies and the spacing of vehicles. The following table provides a summary of the inputs
that should be utilized for NCDOT peak hour analysis projects.

AM Peak PM Peak
_AM_Warmup.mtx _PM_Warmup.mtx

Time Interval: Start Time 07:45:00 08:00:00 16:45:00 17:00:00
Time Intervals: End Time 08:00:00 09:00:00 17:00:00 18:00:00
Matrix Unit Hourly Rate Hourly Rate Hourly Rate Hourly Rate
Time Distribution Constant Over Time Curve-based Constant Over Time Curve-based
Unit Scaling Factor 0.75 1.00 0.75 1.00
Standard Deviation 0.000 0.000 0.000 0.000

Generate Departure
Headways by
Departure Headway
Distribution

Contents Tab

O-D O-D O-D O-D

Random (Uniform) Random (Uniform) | Random (Uniform) | Random (Uniform)

A matrix file can contain multiple matrices. The Contents Tab includes the ability to set additional parameters that
vary by matrix. The default settings for this tab are not typically modified unless vehicle-to-roadside
communication (VRC) sensors for MOE output or if Vehicle Class matrices are being utilized (see Modeling Heavy
Vehicles/Vehicle Fleet: Method 3 for additional information). If VRC sensors are being utilized, the setting for all
matrices should include the Probe column being set to Yes.

Paths Tab

These settings are not typically utilized for NCDOT analysis. Any use of paths shall require approval from the
NCDOT Congestion Management Section.

Curve Tab

When Curve-based is selected for the Time Distribution setting on the Setup Tab, a Curve Tab is added to the Trip
Matrix Settings dialog box. A curve-based time distribution allows discrete time intervals to be created that define
the variation in rate over time. For NCDOT projects, the default curve shall be defined to emulate a PHF of 0.90
with the following percentages assigned to the curve:
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Begin Time Percentage Begin Time Percentage
08:00 25.0% 17:00 25.0%
08:15 27.8% 17:15 27.8%
08:30 25.0% 17:30 25.0%
08:45 22.2% 17:45 22.2%

MODELING HEAVY VEHICLES/VEHICLE FLEET

The modeling of heavy vehicles and the definition of the vehicle fleet for the simulation can have substantial
effects on the operations of the model. TransModeler models heavy vehicles based on a vehicle fleet that defines
the percentage of each vehicle class that is expected to occur. As vehicles are generated in the simulation model,
they are randomly assigned a vehicle class based on the distributions set in the model.

Three methodologies are available for the modeling of heavy vehicles in TransModeler. The most appropriate
method shall be determined on a project-by-project basis during the scoping of the project. The three potential
methodologies are as follows:

e Method 1 — Global Vehicle Fleet: The use of a global vehicle fleet should only be used for projects where
the distribution of trucks is similar for a majority of the roadways being modeled. This methodology
utilizes a single distribution of vehicles such that each entry node assigns vehicles based on the same
distribution of vehicle classes.

e Method 2 — Local Loading Parameters: The use of local loading parameters allows the analyst to establish
multiple distributions of vehicle types and then assign them to each entry node. This method allows for
the analyst to control the distribution of vehicles entering the model; however, it does not allow control
of the vehicles once they enter the model. This method is best for moderate variations in truck volumes
and where the variations are not expected to substantially affect the operations.

e Method 3 — Vehicle Class Matrices: The use of individual matrices for each vehicle class (or set of vehicle
classes) allows the full modeling of vehicles from their origin to their destination. This method should be
utilized when there are substantial variations in truck volumes that are expected to effect the operations
and/or design of a project. For example, if a freeway has a truck percentage of 12 percent and a y-line
interchange has a truck percentage of 2 percent, the only way not to have roughly 12 percent trucks on
the ramps is to utilize matrices for each vehicle class (or set of classes).

Note that consideration should be given to the actual truck volumes and not just their percentage. For example,
a very low volume roadway with a high truck percentage may not produce enough trips in the model to have a
noticeable effect and the use of Local Loading Parameters (or even Global Parameters) may be acceptable.

Vehicle Fleet
The definition of the vehicle fleet in TransModeler will vary depending on the method selected above. For Method
1 and 2, the full distribution of vehicle classes shall be utilized, including the assignment of trucks to the vehicle
fleet. Method 3 will utilize the NCDOT default vehicle fleet without trucks for the non-truck matrices and each
truck matrix will be defined based on a truck vehicle class.

The NCDOT Default Simulation Project file includes a set of vehicle class definitions and a default distribution of
the non-truck vehicle classes (shaded in yellow in the table below) that are based on manual classification counts
of traffic throughout North Carolina. The non-truck vehicle classes include PC1, PC2, PC3, PU, B and M.

For Methods 1 and 2, the vehicle fleet distributions should be modified based on the percentage of trucks that
are to be included in the model. For projects based on a traffic forecast (or other similar work product) the Dual
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classification is equivalent to the ST vehicle class and the TTST classification is equivalent to the TT vehicle class.
For peak period analysis, the daily total truck percentage in the traffic forecast (or other similar work product)
shall be divided by two to determine the truck percentage that shall be modeled in TransModeler. The primary
reason for dividing the truck percentage by two is that it is assumed that the peak hour includes a high percentage
of commuter traffic and that trucks tend to avoid peak travel periods when possible.

Based on the percentage of trucks that are to be modeled, the following table shall be utilized to define the vehicle

classes for the non-truck vehicles.

6.0% |

1.0% | 1.5% 25% | 3.0% | 3.5% | 4.0% | 45% | 5.0% | 5.5%
B so0 | 445 | 443 | 441 | 439 | 436 | 434 | 432 | 430 | 428 | 425 | 423
Bl s | 25 | 25 24 | 24 | 24 | 24 | 24 | 24 | 24 | 24
B o0 | 495 | 202 | 489 | 487 | 486 | 483 | 480 | 477 [ 474 | 472 | 469
BE o2 | o2 | o2 | o2 | o2 | 02| 02| 02| 02| 02| 02| o2
B o: | o3 | 03 [ 03 | 03 | 03 | 03| 03 | 03 | 03| 03| 03
00* | 20* | 15* | 20% | 25% | 30* | 35* | 40* | 45* | 50* | 55* | 60*

9.5% | 10.0% | 10.5% | 11.0% | 11.5% | 12.0%
Yl 1o | 19 | 19 | 18 | 18 | 18 [ 18 | 18 | 18 [ 18 | 18 | 18
421 | 418 | 416 | 414 | 412 | 410 | 407 | 405 | 403 | 400 | 398 | 3956
Sl 23 | 23 | 23 | 23 | 23 | 23 | 23 [ 23 | 22 | 22 | 22 | 22
B +57 | 465 | 462 | 460 | 457 | 454 | 452 | 449 | 447 | aas | as2 | 439
02 | 02 [ 02 | 02 | 02 | 02 | 02 | 02 [ 02 | 02 | 02
03 | 03 [ 03 | 03 | 03 | 03 | 03 | 03 [ 03 | 03 | 03

70* | 75% | 80o* | 85* | 9.0* | 95+ | 100* | 105* | 120* | 115+ | 120*

15.5% | 16.0% | 16.5% | 17.0% | 17.5% | 18.0%
18 | 17 | 17 | w7 | 27| w7 | w7 | 17| 7] 17| 17| 16
394 | 391 | 389 [ 387 | 385 | 383 | 380 | 378 | 376 | 374 | 371 | 3609
22 | 22 22 | 22 2.1 21 | 21 21 | 21 | 21 21 | 21
B w36 | 435 | 432 | 4290 | 427 | 424 | 422 | 419 | 416 | 414 | 412 | 410
B o: | o2 | 02 | o2 | 02 | 02 [ 02 | 02 | 02 | 02| 02 | 02
B o: | o3 | 03 | 03 | 03 | 03 | 03 | 03 | 03 | 02|02 | 02

125% | 13.0% | 135* | 140* | 145+ | 150% | 155* | 160* | 165* | 17.0* | 175* | 18.0*

* denotes the total truck percentage and should be distributed proportionally based on the traffic forecast distribution

Method 1 — Global Vehicle Fleet

The definition of a global vehicle fleet is found in the >Parameters>Vehicle Fleet> Classification>Class> dialog box
and shall be based on the weighted average of trucks that are to be simulated in the model. The weighted average
should be calculated by multiplying the volume on each entry point to the model by the forecast (or other similar
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work product) truck percentage and then dividing by the total entry volume. Once the overall weighted average
is determined, it should be rounded to the nearest one-half percent and the table above shall be utilized to define
the vehicle class distributions in the vehicle class table. For projects that include the analysis of multiple scenarios,
it is preferable to maintain the same distribution for all analysis scenarios, unless there is a substantial change in
truck percentage forecast among the scenarios. The distribution of the truck percentage for ST and TT should be
roughly based on the proportion included in the weighted average.

Method 2 — Local Loading Parameters

The definition of Local Loading Parameters is found in the >5Demand>Local Loading Parameters>Edit Distributions
dialog box. New distributions shall be added by right clicking under the Vehicle Class Distributions heading and
selecting Add. A new distribution should be added for each unique heavy vehicle distribution included in the
traffic forecast (or other similar work product) and generally should be named based on the truck percentage from
the forecast. The appropriate distribution of vehicle fleet (assuming the percentage is divided by two) would then
be selected from the table above and added to the Local Vehicle Class Distribution table. For example, if the
forecast has (4,2) listed for the truck percentages, a new distribution name (4,2) would be added and the
information included under the 3% column above would be added with the ST percentage being set to 2% and
the TT percentage being set to 1%.

Once the new Local Loading Parameter vehicle class distributions are defined, they must be assigned to each entry
node based on the forecast percentages. The next step shall be to add a field to the node (or centroid, depending
on how the traffic is being loaded onto the model) to assign the Local Loading Parameters to each entry node by
selecting > Demand>Local Loading Parameters>Apply Distributions. In the Apply Local Loading Parameters dialog
box, a new field (typically named VehClassDist) is defined for the Node (or Centroid) layers. Once the Local Loading
Parameters field is added to the node (or centroid) layer, the appropriate distribution shall be defined for each
entry node (or centroid) within the model by utilizing the Dataview feature or by another appropriate method.

Method 3 — Vehicle Class Matrices

The utilization of individual matrices for each vehicle class includes disaggregating the overall Origin-Destination
(O-D) matrix into individual matrices that include each vehicle class (or set of classes). If the vehicle class matrices
are utilized, they should include three separate matrices, one for passenger vehicles (PC1, PC2, PC3, PU, B and M),
one for Dual Trucks (ST) and one for Tractor Trailers (TT). Combining the truck matrices into a single matrix may
be acceptable, if approved by the NCDOT Congestion Management Section.

The definition of vehicle class matrices shall be accomplished by defining multiple matrices on the Contents tab
of the Trip Matrix Setting dialog box. The Number of Matrices should be increased to 3 and the Matrix names
(Passenger, Dual, TTST) shall be defined for the three class matrices. The Vehicle Class field shall be defined for
the Dual matrix (select ST) and TTST matrix (select TT) with the Vehicle Class field for Passenger left blank. By
leaving the Vehicle Class field blank for Passenger the default vehicle class definition (>Parameters>Vehicle Fleet>
Classification>Class>) will be utilized for all non-truck trips. Therefore, the default Vehicle Class distribution
(shaded in yellow above) with 0% trucks shall be defined in the global parameter settings.

The development of the individual Vehicle Class matrices should include developing them in a manner that roughly
replicates the total number of trucks (both Dual and TTST) forecast for the model and provides for reasonable
routing of the trucks through the network to roughly maintain the forecast truck percentage on individual links.
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RUN CONTROLS AND SIMULATION SETTINGS

The process of running the simulation requires that several additional settings be defined. As described in the
Project Settings section, each simulation shall include a warm-up period prior to outputs being collected that
allows the network to have background traffic in the network when the analysis period begins.

Each simulation model is time-based, meaning that the simulated time span is divided into discrete time steps.
The vehicle state step size determines the frequency during the simulated time span with which TransModeler
updates the state of each individual vehicle in the network. The NCDOT Default Simulation Project file includes
the time step for microscopic simulation being set to 0.1 seconds and shall not be modified.

The simulation models in TransModeler are stochastic, meaning that they rely on random variables that affect the
outcome of each simulation, effectively making each run like a single observation from a random sample. Running
multiple simulations is required in order to satisfy some minimum level of confidence in the average of the model’s
results. The NCDOT default minimum number of runs for each scenario shall be ten. For the majority of projects,
ten simulation runs should be adequate; however, the analyst shall review the model output data (as described
in the Measures of Effectiveness section) to determine if the number of runs is adequate. This current version of
these Guidelines does not include a firm threshold for determining if ten runs is adequate. But, generally, a review
of the outputs should show that the standard deviation of the output value should not be greater than 50 % of
the average value for any critical measure within a highly congested network.

Each time you run a simulation, TransModeler automatically generates a random seed number with which the
simulation is randomized. Thus, each run will produce a different outcome, and may be viewed as a single
observation in a random sample. While developing a model, it is desirable to maintain the same random seed
numbers throughout the analysis as a means of providing an improved basis of comparison among alternatives.
Therefore, the default random seed numbers shall be 5, 10, 15, 20, 25, 30, 35, 40, 45 and 50 and shall continue in
increments of five if additional runs are required.

DYNAMIC TRAFFIC ASSIGNMENT

TransModeler uses one of a number of route choice models to decide the path each vehicle takes within the
modeled network. Route choice decisions are largely a function of the travel time between a trip’s origin and
destination and are determined based on the user’s generalized cost. Where tolls are included, the overall
generalized costs may be used to combine the effects of travel time and tolls on the route choice decision.

When observed travel times are not available, a simulation-based Dynamic Traffic Assignment (DTA) can be run
in order to estimate "loaded" (i.e., congested) travel times. The idea behind the simulation-based DTA is that by
running the simulation from start to finish iteratively and averaging output travel costs with input travel costs
between each iteration, the network loading will converge toward user equilibrium, where vehicles "learn" from
prior iterations by choosing better paths in each subsequent iteration/simulation until no vehicle can improve its
travel time significantly by switching to an alternative path. When this condition is satisfied, User Equilibrium is
achieved.

Therefore, with networks that have multiple reasonable paths for drivers to travel between major origins and
destinations, the use of DTA should be strongly considered. Without DTA, TransModeler will determine the
quickest travel time for each route based on the free flow travel time along each link and a set delay based on the
turn movement type at each node. For larger networks with multiple route options, this can create problems as,
in most cases, nearly all of the trips between an origin and destination will take the same path through the
network. With all traffic taking the same path, it is common to see substantial delay at key intersections, far
beyond the nominal delay values included in the initial assignment of traffic.
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In order to provide for more realistic operations, DTA should be considered for networks that have a substantial
number of trips that have multiple reasonable route options within the modeled network. If the modeled network
is linear in nature with few or no alternative routes being modeled within the analysis network, then DTA provides
little benefit and should not be included in the analysis. The decision on whether to utilize DTA should be made
in consultation with the NCDOT Congestion Management Section during the scoping of the project.

If it is determined that DTA will be utilized for a project, then it should be utilized for all scenarios being modeled
to allow for an appropriate basis of comparison of the results of the simulation. The input criteria for DTA includes
determining either a convergence criteria or a maximum number of simulation runs for iteration. The
convergence criteria are based on the calculation of the relative gap (statistical measure of how much variation
there is between each simulation run) and looks at the overall model operations. While the use of relative gap
does a good job of determining the stability of the network overall, it may not be fully reflective of the stability
for individual O-D pairs. Due to this, it has been determined that for NCDOT analysis, a minimum number of
iterations will be utilized in lieu of the relative gap criteria. Therefore, the following minimum number of iterations
should be run, based on the number of intersections in the network:

e < 9intersections = 25 iterations

e 9-15 intersections = 50 iterations

e 16-30 intersections = 100 iterations

e > 30 intersections = determined on a project by project basis

Note that this is the minimum number of iterations. Following the completion of the DTA runs, the model shall
be reviewed in detail to determine that the paths utilized during the simulation are reasonable. If the paths are
not reasonable, it is likely that the model has not yet reached equilibrium and additional DTA runs should be
completed, each time checking the paths to determine that they are reasonable. When reviewing the simulation
model following DTA, the best tool for determining if the operations and paths are reasonable is through the use
of the Path Toolbox (>Demand>Path Toolbox) during the simulation of the model. The Path Toolbox allows the
analyst to review the travel time and volume for each potential O-D route within the model.

The DTA process is run for each scenario utilizing the Simulation Options Toolbox (>Simulation>Options) and
setting the Run input to Dynamic Traffic Assignment. The following Dynamic Traffic Assignment Settings shall be
used:

e Relative Gap = 0.00

e Maximum lterations = based on information above
e FirstGap—2>1

e Gap Interval > 10

e Interval = 15 minutes

e Path Update Threshold = 0%

e Averaging 2 Method of Successive Averages

Under the Configure Assignment Output dialog, the file names for the output should be named based on the
default naming conventions as follows:

{TIP or Project No.}_{Analysis Year or Years} {Scenario} {Alternative (if applicable)} {AM or PM}_{Output Type}
For example:

e |-0000_2040_Build_Alternative 1_AM_Historic Travel Times.bin
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e |-0000_2040_Build_Alternative 1_AM_Travel Time Variability.bin
e |-0000_2040_Build_Alternative 1_AM_Turning Delays.bin

e |-0000_2040_Build_Alternative 1_AM_Path Flow Table.bin

e |-0000_2040_Build_Alternative 1_AM_Path Table.pth

The Options section shall include the Fix Random Seed option not being selected. The number of routing and
simulation threads may be set to Max or any number to allow for the run times to be minimized.

Once the simulation-based DTA has been run, the Historic Travel Times.bin and Turning Delays.bin files shall be
added to the Routing Tab in the Project Settings dialog (>Project>Settings>Routing tab) in the Travel Time and
Turning Delay fields, respectively.

Dynamic Traffic Assignment Best Practices
The utilization of DTA requires the analyst to make a critical review of the operations within the network in order
to determine that the routing is reasonable. There are several best practices to consider when utilizing DTA.

Because DTA learns from previous iterations, if there are substantial changes in a model network, it is often best
to re-run the DTA process without travel time or delay files included in the routing tab. This is referred to as “clean
DTA” and starts with the free-flow travel times. The primary reason for running a clean DTA is that it may take
the DTA process many iterations to unlearn a pattern that is no longer present and optimize towards a better
solution. If there are only minor variations in the network, then it is often best to keep the previous travel time
and delay files when running additional iterations with DTA, as it will preserve the previous efforts and provide a
better starting basis moving forward.

If there are several paths that have very similar travel times, it can take DTA many iterations to reach a point of
equilibrium; therefore, the use of the Path Toolbox and detailed observation of the model is critical to determine
that the operations have stabilized. If it is observed that traffic is changing the preferred path frequently
throughout the simulation, it is an indication that equilibrium has not been reached and that additional iterations
may be warranted.

VISUAL VALIDATION

The development of simulation models in TransModeler is based primarily on the default parameters and
guidance provided in this document. However, the default values were developed to attempt to capture average
driver behaviors for typical North Carolina drivers. Default settings may not always capture location specific
operations; therefore, visual validation should be considered as a means of better replicating the real world
operations. Further refinement of the model, through calibration, can be undertaken to develop the model to a
level where it replicates (within a statistical level of certainty) the operations of the actual network. The following
are three potential levels of analysis for NCDOT Projects:

o Level 1 - Default Values: Under this scenario, the default values, parameters and coding guidance shall be
implemented and no additional modification to the model (beyond standard error checking and quality
control) will be made.

e Level 2 — Visual Validation: Under this scenario, the model will first be developed utilizing the default
values, parameters and coding guidance. Following the standard error checking and quality control, the
model will be reviewed visually and compared in a qualitative manner to the observed field operations.
Changes to model parameters that allow the model to better replicate, in a visual manner, the observed
field operations can be undertaken, with all modifications documented. The goal of visual validation is to
develop a model that reasonably replicates the actual field observed observations.
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e lLevel 3 — Calibration: Under this scenario, the process of refining the model to replicate the field
operations is expanded to include statistical evaluation of the model against field collected data sets to
determine that the model, within a degree of certainty, is replicating real world operations. This level is
reserved for very large projects, typically including freeway operations, and requires a substantial level of
effort.

Quality Control and Error Checking
Quality Control of the model shall also be performed on all models prior to submittal to NCDOT. A detailed review
of the model for quality control should be done by an individual with a thorough understanding of TransModeler
and these Guidelines. A second, independent review of the model by an individual who has expertise in traffic
operations but was not involved in the development of the model is also recommended prior to running any
outputs.

The process of developing the model includes several review steps, primarily by means of error-checking the
model, between the initial model development steps and the actual running of the model for outputs. The FHWA
Traffic Analysis Toolbox Volume Ill: Guidelines for Applying Traffic Microsimulation Modeling Software includes
Chapter 4 which details the steps for Error Checking.

Error checking involves various reviews of the coded network, coded demands and default parameters. Error
checking proceeds in three basic stages: (1) software error checking, (2) input coding error checking and (3)
animation review to spot less obvious input errors.

Review Software Version/Build - The analyst should review the software website or coordinate with Caliper to
ensure that he or she is aware of the latest Build of the software. Caliper regularly updates TransModeler with
new Builds of the software; however, most of these are minor changes and don’t typically modify key driver
behaviors. NCDOT will update the current Build of the software at least twice a year (or more frequently if a major
change in driver behavior is included in a new Build) and provide information on the current Build being utilized
on their website. The analysis should be developed in the current Build being utilized at the time the Notice to
Proceed for the study is issued. For projects not requiring calibration, updating to any more recent Build of the
software is acceptable as long as all output is run in the same Build of the software. For projects requiring
Calibration, the Build utilized to calibrate shall be utilized for the entire project unless a change is approved by the
NCDOT Congestion Management Section.

Review Input = All of the input data utilized to develop the model should be reviewed in detail, including the:

e Link and Node network
e Demand and Vehicle Input
e Driver behavior and vehicle characteristics.

Review Animation - Animation output enables the analyst to see the vehicle behavior that the model returns and
assess the reasonableness of the microsimulation model itself. Running the simulation model and reviewing the
animation, even with artificial demands, can be useful to identify input coding errors. During this process, the
analyst would input a very low level of demand and then follow individual vehicles through the network. Abnormal
vehicle behavior (such as unexpected braking or stops) is a quick indicator of possible coding errors. A three-stage
process can be followed in reviewing the animation output:

e Run the animation at an extremely low demand level (so low that there is no congestion). The analyst
should then trace single vehicles through the network and see where they unexpectedly slow down. These
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will usually be locations of minor network coding errors that disturb the movement of vehicles over the
link or through the node. This test should be repeated for several different O-D zone pairs.

e Once the extremely low demand level tests have been completed, then run the simulation at 50 percent
of the existing demand level. At this level, demand is usually not yet high enough to cause congestion. If
congestion appears, it may be the result of some more subtle coding errors that affect the distribution of
vehicles across lanes or their headways. Check entry and exit link flows to verify that all demand is being
correctly loaded and moved through the network.

e Run the animation with an extremely high demand, where the network will break down and the queuing
behavior can be observed. Running the network with high volumes, which may be present in the future
year analysis, is helpful in finding coding errors. The analyst should hypothesize on where the network
will breakdown first and how the network will respond to congestion. After running the simulation, the
actual operations should be compared to this hypothesis to see if it is operating as expected.
Understanding how and why a model breaks down under heavy traffic can help to find coding errors and
improve the operations of the model. Completing this task fully during the base year analysis can save a
lot of time as it often eliminates coding errors found when analyzing future year operations that require
re-running the base year model to correct the issue.

Level 1 — Default Values
As described above, the use of the NCDOT default values, parameters and coding guidance shall be implemented
in developing the model, with no additional modification of parameters. The model will then be run utilizing the
default parameters and the outputs for various scenarios can be compared. At this time, the NCDOT default values
are still being developed and refined; therefore, not all operations will closely match the actual field operations.

Level 1 analysis should generally be utilized for the following scenarios:

e Where there are low to moderate traffic volumes that are not expected to create an over-capacity
condition or substantial levels of congestion.

e  Where the primary goal is to compare alternative scenarios to one another. The use of default values
would allow for a full comparison. However, the use of only default values may be less reliable for the
actual design of the facility being analyzed.

e Where the proposed or future condition does not currently exist or where the future year scenario varies
substantially from the base year configuration (for example, upgrading an arterial to a freeway).

Level 2 — Visual Validation

As described above, visual validation includes modifying parameters within the model to better replicate the real
world operations observed in the field. The use of visual validation requires that traffic be observed in the field
during at least the critical peak period. The model should be reviewed and parameters adjusted to allow the
model to better represent the real world conditions. For projects involving an NCDOT forecast, the model should
be visually validated to match the worse of the AM or PM peak hours. The current forecast procedure includes
assuming the AM peak is a mirror image of the PM peak, which is often not true in reality; therefore, validation of
the worse peak provides the most meaningful results.

The process of selecting and modifying parameters requires an understanding of how the model operates and the
relationships of the parameters within the model. Research into many of these parameters is ongoing and is being
undertaken in an effort to provide better input as to which are the best parameters to be reviewed and modified.
Therefore, the threshold for developing visually validated models will be left up to the analysts’ discretion until
improved guidance is provided.
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If any of the default parameters are modified, the modification shall be documented in the model documentation
and the default parameters file (NCDOT_Default_Parameters_Date_Terrain.xml) in TransModeler shall be
renamed with the _Default_ portion of the file name modified to the TIP or Project Number and the _Date_
portion updated to the date of the modification. For example, if a level terrain model for U-0000 modified the
default parameters in December 2016, the file would be renamed: NCDOT_U-0000_Parameters_12-
2016 _Level.xml

The following parameters, through a limited amount of research, have proven to be prime candidates for selection
in visually validating the model:

e Shifting of the Desired Speed Distribution Curve (>Parameters>General>Desired Speed>). The default
distribution (driver population and deviation from speed limit increment) should generally be maintained
but the actual values in the deviation from speed limit can be shifted up or down.

e Maximum Turning Speed (>Parameters>Vehicle Fleet>Performance>Maximum Speed>Intersection>).
Modifying the turning speeds at intersections can increase or decrease the saturation flow at the
intersection.

e Headway Threshold and Buffer (>Parameters>Driver Behavior>Acceleration>Headway>Thresholds or
Buffers). Modifying this parameter affects the spacing between vehicles and the threshold between
emergency braking, following regime and free flow regime.

e Discretionary Lane Changing Behavior (>Parameters>Driver Behavior>Lane Changing>Discretionary
(DLC)>Neighboring Lane Model> Lane Choice Utility Function>), including:

o Path Influence Factor
o Heavy Vehicle Ahead
o On-Ramp Ahead

o Off-Ramp Ahead

o Weaving Influence

e Mandatory Lane Changing Behavior, (>Parameters>Driver Behavior>Lane Changing>Mandatory
(MLC)>Critical Distance> General Fleet>)

e Stopped Gaps (>Parameters>General>Microscopic Parameters>Stopped Gaps) controls the spacing of
vehicles when queued. This parameter can increase saturation flow rate at intersections if increased
slightly, but tends to have an opposite effect on freeways discharging from queues during congestion.

e Lane Connector Connectivity Bias. This may be modified for freeway merges only to increase the
likelihood of a vehicle merging onto the freeway earlier.

The range of reasonable values for which parameters can be modified is not well understood at this point and
additional evaluation of a parameter’s sensitivity is being reviewed and will be included in future revisions to
these Guidelines. Generally, constraining any variation between halving and doubling the value is a good rule of
thumb for the limits of what is a reasonable modification to parameters.

Level 3 — Calibration

The process for developing calibrated models is typically reserved for projects that require additional precision in
the evaluation of alternatives. Projects involving the modification of Interstate highways and their interchanges
typically require calibration as part of the Interchange Access Report (IAR) required by FHWA. The goal of
calibration is to develop a model that is able to reproduce, within a reasonable margin, actual field-collected data.
At this time, additional research is needed before a NCDOT standard can be established for calibration thresholds.
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MEASURES OF EFFECTIVENESS

The purpose of computing one or more traffic performance Measures of Effectiveness (MOE) is to quantify the
achievement of a project's traffic operations objectives and to compare alternatives against one another. The
selection of MOEs should be driven by the project objectives and the NCDOT performance standards for the facility
being modeled.

The selection of MOEs for any analysis is critical, especially as the FHWA Traffic Analysis Toolbox cautions against
the use of LOS in comparing simulation results to the Highway Capacity Manual (HCM) derived results. It notes
that the analyst needs to review the software documentation to understand the differences and to be sure that
the microsimulation software is calculating LOS properly. Based on a review of the TransModeler documentation
and discussions with the software developer, Caliper, NCDOT feels comfortable that the software appropriately
presents the LOS results in a manner that is consistent with the HCM 2010 methodologies. However, to be clear
that there is a difference between the empirically derived HCM methodologies and those derived through
simulation, “LOSs” is being utilized to denote that the LOS is a simulation based LOS result.

Several additional considerations must be evaluated when determining how to interpret simulation based MOEs.
According to the FHWA Traffic Analysis Toolbox, the analyst needs to determine if the alternatives should be
evaluated based on their average predicted performance or their worst case predicted performance. Typically,
the worst case predicted performance is determined based on a calculation of the 95" percentile result.
Additionally, the HCM 2010 methodologies are based on an analysis of the peak hour of the day, with a further
adjustment to the peak 15-minute period within the peak hour for the analysis. NCDOT has determined that the
most appropriate application for LOSs shall include extracting the data in one-hour increments and applying the
following formula (taken from Section 6.3.3 of the FHWA Traffic Analysis Toolbox, Volume Ill) to determine the
95t percentile worst result:

95%Worst Result=m+ 1.64 ¢ s

where:
m = mean observed result in the model runs
s = standard deviation of the result in the model runs

In general, there are four types of MOEs that may be generated for a simulation project, including:

e System or Network Wide MOEs
e Corridor MOEs

e Uninterrupted Flow MOEs

e Interrupted Flow MOEs

During the scoping of the project, the potential MOEs described in the following sections should be reviewed and,
based on the objectives of the project, a set of appropriate MOEs shall be selected.

System or Network Measures of Effectiveness
System or network level MOEs are collected for the entire network being modeled for a prescribed time period

and provide measures of the overall system performance. The following are potential outputs that may be
selected based on the objective of the project:

e Number of Trips - Total number of trips in a given time period
e Trip Length - Total travel distance averaged over all vehicles
e VMT - Vehicle miles traveled; the sum total distance traveled by all vehicles
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e VHT - Vehicle hours traveled; sum total travel time experienced by all vehicles

e Average Speed - Travel speed averaged over all vehicles

e Delay - Total difference between experienced travel time and free flow travel time, summed over all
vehicles

e Average Delay - Total difference between experienced travel time and free flow travel time, averaged
over all vehicles

e Stopped Time - Total stopped time experienced by all vehicles

e Average Stopped Time - Total stopped time experienced during a trip averaged over all vehicles

e Number of Stops - Total number of stops experienced by all vehicles

e Average Stops - Total number of stops experienced during a trip averaged over all vehicles

For each selected MOE, the average and 95" Percentile Worst Result for all simulation runs (minimum of ten
model runs) shall be calculated and reported for the one-hour peak period simulated.

Corridor or Route Measures of Effectiveness
There are several MOEs that can provide output for individual corridors or specific routes within a model network.
This type of MOE is beneficial for comparing alternatives and to show the change in travel time or speed along
corridors or defined routes. The following Corridor or Route based MOEs may be selected based on the objective
of the project:

e Travel Time — travel time along a corridor or between select points in a model. Several methods may be
utilized to extract this data from the model output. The preferred methods include either utilizing the
Trips Statistics O-D Matrix output or a VRC Sensor Matrix. It may also be acceptable for less complex
networks to utilize Flow & Travel Time output data for each link and aggregate the data for a corridor or
route. The method of travel time output should be determined during the scoping process

e Average Speed — average speed along a corridor or between select points in model. Average speed is
collected in the same manner as travel time as they are closely related. The same method utilized for
travel time shall be utilized for average speed.

e Segment Speed — average speed along each segment (or combination of segments) along an
uninterrupted flow facility based on the Flow & Travel Time output from TransModeler. Segment speed
should not be utilized for interrupted flow facilities.

e Planning Time Index (PTI) — The planning time index along a corridor or between select points in a model
is a measure of the travel time reliability. The planning time index is calculated by dividing the 95"
Percentile Travel Time by the Free Flow Travel Time with the idea that a PTI of 1.0 is ideal. The
determination of the Travel Time shall utilize the same method as was utilized for Travel Time above. The
Free Flow Travel Time is a simulation based Free Flow Travel Time calculated in the same manner that is
based off of running the model with a low volume that creates free flow conditions along the corridor.
The low flow volumes are developed by scaling the O-D matrices back to a level where it is free flow, but
care should be given that there are at least 50 vehicles completing each route to ensure a level of statistical
validity.

For each selected MOE, the average and 95™ Percentile Worst Result for all simulation runs (minimum of ten
model runs) shall be calculated and reported for the one-hour peak period simulated.

Heat Maps
The use of heat maps that display the results along a corridor visually haven proven to be beneficial in conveying
results to non-technical staff and the public. Consideration should be given, especially on projects with
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controversial elements or an elevated interest by the public, to developing heat maps of corridor statistics (travel
time, speed, LOSs, etc.) to convey the model outputs. Heat maps should be developed to graphically, through a
color coded theme transitioning from green to red, convey the information. Heat maps will likely include an
increment of less than one-hour (with fifteen minutes as the recommended increment) and should utilize the
average results (as opposed to 95" Percentile Worst Case) for all runs with increments less than one hour.

Uninterrupted Flow Measures of Effectiveness
There are several MOEs that can be utilized to provide output for uninterrupted flow facilities, including freeways,
multilane highways and two-lane highways. The use of uninterrupted flow MOEs for multilane and two-lane
highways should not be utilized along corridors that include signal spacing of less than 2 miles or for facilities with
a significant presence of on-street parking, heavily used bus stops, or significant pedestrian activity.

Freeway Facilities
The evaluation of MOEs for freeway facilities shall include determining the density and corresponding LOSs of each
segment along the freeway. TransModeler will segment the freeway facility, if properly coded with freeway and
ramp road classes, based on the methodology included in the HCM 2010 Chapter 10 (Freeway Facilities) into Basic
Freeway Segments, Ramp Merge/Diverge Segments and Freeway Weaving Segments.

The threshold between LOS E and F for Ramp Merge/Diverge Segments and Freeway Weaving Segment is when
the demand exceeds the capacity of the facility. In a microsimulation model, capacity is essentially a model
output, not an input; therefore, determining when a segment exceeds capacity requires additional in-depth
analysis of the operations. TransModeler has a methodology for determining if the segment is over capacity;
however, with the aggregation of data across multiple runs, determining this is much more difficult. Due to the
difficulty in determining this threshold, NCDOT has decided to utilize the density of 45 pc/mi/In as the upper limit
of LOSs E, with any value exceeding it being reported as LOSs F, which is consistent with the definition for Freeway
Facilities included in Chapter 10 of the HCM.

In TransModeler, at each merge or diverge segment, a 1500-foot influence area is determined to calculate the
density. For merge or diverge areas that include less than 1500 feet of acceleration or deceleration length,
TransModeler will create what is known as a Partial Basic Segment that includes the calculation of the density for
the segment outside of the merge or diverge influence area. When developing outputs, the results should be
aggregated together and reported in a manner consistent with HCM 2010 Chapter 10. TransModeler will
aggregate the results for multiple segments that make up a single Basic Freeway Segment; however, it does not
aggregate data for partial basic segments into the overall basic freeway segment. Therefore, the density for Basic
Freeway Segments that include partial basic segments shall be calculated based on a weighted average of the
densities according to each segments total length.

The density, and corresponding LOSs, shall be reported as the 95th Percentile Worst Result for all simulation runs
(minimum of ten model runs) and shall be calculated and reported for the one-hour peak period simulated.

Multilane Highways
The evaluation of multi-lane highways in TransModeler is implemented based on the methodologies presented in
Chapter 14 of the HCM 2010. The primary measure for Multilane Highways is the density along each segment and
the corresponding LOSsand is collected utilizing the Flow & Travel Time output with the Multilane Highway Level
of Service group.

The density and corresponding LOSs, shall be reported as the 95th Percentile Worst Result for all simulation runs
(minimum of ten model runs) and shall be calculated and reported for the one-hour peak period simulated.
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Two-lane Highways
The evaluation of Two-lane Highways in TransModeler is based on the Percent Time Spent Following for each
facility based on the Two-Lane Highway Class. The three classes of Two-Lane Highways are defined as follows:

o (lass | two-lane highways are highways where motorists expect to travel at relatively high speeds. Two-
lane highways that are major intercity routes, primary connectors of major traffic generators, daily
commuter routes, or major links in state or national highway networks are generally assigned to Class I.
These facilities serve mostly long-distance trips or provide the connections between facilities that serve
long-distance trips.

e (lass Il two-lane highways are highways where motorists do not necessarily expect to travel at high
speeds. Two-lane highways functioning as access routes to Class | facilities, serving as scenic or
recreational routes (and not as primary arterials), or passing through rugged terrain (where high-speed
operation would be impossible) are assigned to Class Il. Class Il facilities most often serve relatively short
trips, the beginning or ending portions of longer trips, or trips for which sightseeing plays a significant
role.

e (lass Il two-lane highways are highways serving moderately developed areas. They may be portions of a
Class | or Class Il highway that pass through small towns or developed recreational areas. On such
segments, local traffic often mixes with through traffic, and the density of unsignalized roadside access
points is noticeably higher than in a purely rural area. Class Ill highways may also be longer segments
passing through more spread-out recreational areas, also with increased roadside densities. Such
segments are often accompanied by reduced speed limits that reflect the higher activity level.

The Two-Lane Highway Class, Percent Time Spent Following, and corresponding LOSs, shall be reported as the
95th Percentile Worst Result for all simulation runs (minimum of ten model runs) and shall be calculated and
reported for the one-hour peak period simulated.

Interrupted Flow Measures of Effectiveness
The evaluation of MOEs for interrupted flow facilities is primarily based on the delay, LOSs and queue length at
each intersection within the model network. The data included in the following sections shall be included for all
intersections within the model network. The output shall be arranged in a reasonable manner such that allows
for an orderly review. In general, the network should be presented along each corridor from west to east and
from south to north along the corridor. The outputs should also be labeled based on the cardinal directions
(Northbound, Eastbound, Southbound and Westbound) unless there is justification for varying from this
requirement. For reporting purposes, the approaches of the intersection should be ordered beginning in the
Southbound direction, continuing clockwise (Southbound, Westbound, Northbound then Eastbound) while
movements at each intersection should be listed from left to right in the direction oriented toward the intersection
(for example: WB Left, WB Through then WB Right). During simulation it is possible that individual movements
may not always include any volume during the simulation. Movements with zero volume shall not be listed with

zero delay (zero queue length or as LOSs A) nor be removed from the analysis. Instead, any movement that reports
zero volume shall be noted with “N/A” for all of the reported MOEs and an appropriate note stating that no
volumes were simulated for the given movement. In TransModeler, the definition of lane groups varies from the
definition used by other software packages. Lane Groups are defined for each unique movement or set of
movements. For example, an approach with a left/through, through, through/right and exclusive right lane would
have a total of four lane group corresponding to each unique configuration. All output should be developed to
the lane group definition applied by TransModeler.
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Queue Lengths
The reporting of queue length shall be done utilizing both the Lane Queue output and the Spillback Queue output
in TransModeler. The Lane Queue output shall report the Queue Length and the Spillback Rate for each lane
group within each intersection, unless the lane is at an unsignalized intersection and does not have any conflicting
movement. The Spillback Queue output shall report the Maximum Spillback Queue Length by Approach for each
approach to an intersection. All Queue Length calculations shall be based on the 95" Percentile Worst Result for
all simulation runs (minimum of ten model runs) and shall be calculated and reported for the one-hour peak period
simulated. The Queue Spillback Rate shall be based on the average of the Spillback Rate for all of the simulation
runs (minimum of ten model runs) and shall be calculated and reported for the one-hour peak period simulated.

For the analysis of Build designs, the length of turn bays should generally accommodate the 95" percentile queue
length reported at the lane group level. If the 95 percentile queue length cannot be accommodated in the design,
justification shall be included in the model documentation.

Signalized Intersections
In addition to the Queue Length, the Control Delay by Intersection and Control Delay by Lane Group and their
corresponding LOSs shall be reported for the overall intersection and each individual lane group. The Control
Delay calculations shall be based on the 95" Percentile Worst Result for all simulation runs (minimum of ten model
runs) and shall be calculated and reported for the one-hour peak period simulated.

Unsignalized Intersections (Stop or Yield Controlled)
In addition to the Queue Length, the Control Delay by Lane Group and their corresponding LOSs shall be reported
for any individual lane group that has a conflicting movement. The Control Delay calculations shall be based on
the 95 Percentile Worst Result for all simulation runs (minimum of ten model runs) and shall be calculated and
reported for the one-hour peak period simulated.

Note there is not an overall LOSs for unsignalized intersections in the HCM methodology; therefore, overall
Intersection Control Delay or LOSs shall not be reported for unsignalized intersections. There is currently no
methodology for determining the control delay or LOS for yield controlled movements (with the exception of
roundabouts); therefore, for those in close proximity to signals, they shall be modeled as part of the signal (as
noted in the Intersection Coding section). For yield controlled intersections that are not in close proximity to a
signalized intersection, Queue Length shall be reported for each yield controlled approach with a note that delay
and LOS are not reported for yield controlled intersections.

Roundabouts
In addition to the Queue Length, the Control Delay by Lane and their corresponding LOSs shall be reported for
each approach lane to a roundabout. The Control Delay calculations shall be based on the 95 Percentile Worst
Result for all simulation runs (minimum of ten model runs) and shall be calculated and reported for the one-hour
peak period simulated.

Urban Street Segments and Facilities
NCDOT adopted a Complete Streets policy in July 2009 and published the NCDOT Complete Streets Planning and
Design Guidelines in July 2012. The NCDOT Congestion Management Section is in the process of determining how
to best implement the Complete Streets Guidelines and the HCM 2010 methodology for Urban Street Segments
and Facilities. Future versions of these Guidelines will include additional guidance on how these principles will be
applied to NCDOT traffic operations studies.
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Interchange Ramp Terminals and Alternative Intersection Designs
The HCM 2010 includes a specific methodology for evaluating interchange ramp terminals and the forthcoming
6" Edition of the HCM will include methodologies on evaluating Alternative Intersection Designs. Until these
methodologies are reviewed in finer detail in TransModeler, those types of treatments should be analyzed as
individual intersections. Future versions of these Guidelines will include additional guidance on how these
principles will be applied to NCDOT traffic operations studies.

Best Practices for Developing Measures of Effectiveness
The proper configuration of Superlinks is critical to ensuring that the output MOEs are collected and that the delay
and queue lengths reported are consistent with those in the simulation model. All networks shall be thoroughly
reviewed to ensure that the Superlinks settings are properly configured to extract the output correctly.

The utilization of Selection Sets in TransModeler is an extremely effective tool that both assists in the extraction
of data and amount of time it takes to run the simulation. A thorough understanding of how to utilize selection
sets in the development of MOE outputs is highly recommended.

TECHNICAL DOCUMENTATION

Technical documentation of traffic analysis shall consist of a report, with appendices as necessary, along with a
listing and justification of any default parameters that were adjusted for the project. In the future, a sample
technical report will be provided as a go-by. But in the interim, technical reports should consist of the following
sections:

1. Executive Summary — Provide a brief summary of project purpose, results for each analysis scenario, and
any recommendations made.

2. Project Background — Briefly describe the purpose of memo and project description.
3. Description of Scenarios Analyzed — Provide a description of each scenario analyzed.

4. Methodology — Describe the methodology for the microsimulation, including the TransModeler (or
TransModelerSE) release version and build number. A brief description of the visual validation that was
conducted and any anomalies may be included here. Also state whether previous TransModeler models
were used to develop this analysis and, if so, the pertinent information of that model (date, project,
software version, etc.).

5. Measures of Effectiveness — Provide a description of the measures of effectiveness (MOEs) selected for
the project. The MOEs to be provided are detailed in these guidelines.

6. Volume Development-Provide a description of volume development methodology and any
unconventional treatment to the development of volumes.

7. Deviations from Default Values — Provide a list of any default values that were modified in the analysis,
including a brief justification for the deviation. Approval of the deviations shall be included in an Appendix
to the report.

8. Base Year No-Build Analysis — Provide a description of Base Year No-Build scenario and analysis results,
including any notable concerns that arose during visual validation.

9. Future Year No-Build Analysis—Provide a description of Future Year No-Build scenario and analysis results,
including any notable concerns that arose during visual validation.
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10.

11.

12.

Future Year Build Analysis—Provide a description of Future Year Build scenario and analysis results,
including any notable concerns that arose during visual validation. If multiple build alternatives were
analyzed, include description and results for each.

Base Year Build Analysis (if applicable)—Provide a description of Base Build scenario and analysis results,
including any notable concerns that arose during visual validation. Also include illustrations of the signal
timings used for each intersection in each peak period. If multiple build alternatives were analyzed,
include description and results for each.

Conclusions and Recommendations — Provide a brief description of the conclusions and any
recommendations developed based on the analysis results. Discuss any counterintuitive results.

The following tables should be provided in the technical report:

1.

2.

3.

4.

Base Year No-Build Measures of Effectiveness
Future Year No-Build Measures of Effectiveness
Future Year Build Measures of Effectiveness (include tables for each build alternative analyzed)

Base Year Build Measures of Effectiveness, if applicable (include tables for each build alternative analyzed)

The following figures should be provided in the technical report or appendices of the technical report:

1.

2.

10.

11.

12.

13.

Project and Model Study Area (distinguish between the project study area limits of the analysis model)
Base Year No-Build Volumes

Base Year No-Build Laneage

Base Year No-Build MOEs

Future Year No-Build Volumes

Future Year No-Build Laneage

Future Year No-Build MOEs

Future Year Build Volumes (for each build alternative)

Future Year Build Recommended Laneage (for each build alternative)
Future Year Build MOEs (for each build alternative)

Base Year Build Volumes (if applicable)

Base Year Build Recommended Laneage (if applicable)

Base Year Build MOEs (if applicable)

SUBMITTAL REQUIREMENTS

The following items should be included in a submittal package:

A completed Submittal Checklist, with justification given for anything not included in the submittal
package.
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e Archived models following the naming convention outlined in the File Naming Conventions section. The
following settings should be verified in the model before the archive zip folder is created:

o Turn off all labels

o Turn off all color themes

o Make all selection sets inactive
e  MOE Spreadsheets
e Technical Documentation

For review purposes, a printable digital copy of the report/documentation submittal is preferable, although
NCDOT may require hard copies as well. The number of hard copies will be determined during the scoping process
of each project. For plan sheets, such as site plans, the digital submittal should be legible and to scale when
printed as a 22”x34” sheet. Use of the Portable Document Format (PDF) is preferred.

CALIBRATION
This section will be developed in a future version of these Guidelines.

MULTI-HOUR SIMULATION MODELS
This section will be developed in a future version of these Guidelines.

TRAFFIC IMPACT ANALYSIS
This section will be developed in a future version of these Guidelines.
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ATTACHMENT A — MODIFICATIONS TO DEFAULT TRANSMODELER FILES

TransModeler Preferences (tsm user.xml)
The following revisions were made to the default file:

>Display Options>Feature Sizes>Centroids>Radius changed to 50 ft.

>Display Options>Lane Markings and Medians>Turning Movement Arrows>Setback changed to 40 ft.
>Display Options>Pedestrian Crosswalks>Color>Empty changed to color #2 (white)

>Display Options>Minimum Scales> Turning Movement Arrows changed to 1:4000

>Display Options>0Other Options>Default Background Color changed to color #75 (dark grey)

>Default Project Settings>Simulation Start Time changed to 07:45

>Default Project Settings>Warm-up period changed to 15 minutes

>Default Project Settings>Show Optional Settings>Routing Settings for Simulation Route Choice selected
>Default Project Settings>Show Optional Settings>Project and Model Parameters selected

>Default Project Settings>Output Options>Report Start Time set to 08:00 and End Time set to 09:00
>Default Project Settings>Options>Travel Time and Delay> Enforce Free Flow Travel Time as Minimum selected
>Default Project Settings>Options>Travel Time and Delay> Enforce Global Penalties as Minimum selected
>Default Project Settings>Assignment>Maximum Number of Iterations set to 50

>Default Project Settings>Assignment>Convergence set to 0.0001

>Road Editor>Parameters>0Other>Automatically Update Segment Elevation Based Elevation selected
>Road Editor>Options>Transparent Links and Segments selected

>Road Editor>Options>Fade Background changed to 25%

>Intersection Control Editor>Phase Design>Controller Type changed to Type 170

TransModeler Parameters (NCDOT Default Parameters 09-2016 Terrain.xml)
The following revisions were made to the default file:

>General>Model Mechanics>Geometry>Turn Capability>Maximum Vehicle Length Allowed for U-turn changed to
200 feet

>General>Desired Speed>Distribution> Modified based on following Table:

Deviation from Speed Limit (mph) % of Driver Population

Level Rolling Mountainous | Freeway Standard High Low
Compliance compliance

-10 -7.5 -5 0.5 1 1 1

-5 -2.5 0 9.5 9 14 9

0 2.5 5 25 20 40 15

5 7.5 10 30 30 30 25

10 12.5 15 25 30 10 30

15 17.5 20 9.5 9 4 15

20 22.5 25 0.5 1 1 5
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1743

1744
1745

1746

1747
1748

1749

1750

1751

1752

1753

1754

1755

>General>Desired Speed>Lane Adjustments>Lane Speed Factors> Modified based on following Table:

Number of | Lane 1 (Left)

Lane 5+ (Right)

>Vehicle Fleet>Classification>Class> Modified based on following Table for passenger car only distribution:

Percentage \ Name | Description

2.0 PC1 High Performance Passenger Car
45.0 PC2 Middle Performance Passenger Car
2.5 PC3 Low Performance Passenger Car
50.0 PU Pickup Trucks, vans, and SUVs

0.2 B Buses

0.3 M Motorcycles

>Vehicle Fleet>Size>Vehicle Size by Class > Changed TT settings to 43 ft. min, 55 ft mean length to correspond
with WB-50 dimensions

>Vehicle Fleet>Appearance>Vehicle Appearance by Class> Changed TT Line 2 to blank to remove double trailers

>Vehicle Fleet>Attributes>Vehicle Attributes by Class> Changed PCE based on HCM 2010 (Exhibit 11-10) by Terrain
Classification

Class Passenger Car Equivalent (PCE)
Rolling Terrain

PC1 1.00 1.00 1.00
PC2 1.00 1.00 1.00
PC3 1.00 1.00 1.00
PU 1.00 1.00 1.00
ST 1.50 2.50 4.50
T 1.50 2.50 4.50
B 1.50 2.50 4.50
M 1.00 1.00 1.00

>Vehicle Fleet>Performance>Maximum Speed>Intersection> Changed values based on following table:

Mass (lbs) | Left U-turn | Left

3307

18

| Slight Left | Straight ‘ Slight Right ‘ Right
55

40 12

>Driver Behavior>Roundabouts>General>Priority Belongs to> Changed to Inside Lane

>Response to Traffic Control>General>Traffic Signals>RTOR Allowed in Right Most Lane Only> unchecked selection

>Response to Traffic Control>General>Traffic Signals>Run Yellow Threshold> changed to 4.0 seconds

>Response to Traffic Control>Compliance Rates>Lane Change Rules (General)> changed to 0.0

>Pedestrian Crosswalk>Walk Time>Walk Duration>Walk Speed (ft/s)> changed to 3.5 per MUTCD

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Min Green> changed to 7 seconds
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1757

1758

1759

1760

1761

1762

1763

1764

1765

1766

1767

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Added Initial/Actuation> changed to 2 seconds
>Traffic Control Defaults>Timing>Default>Default Phase Settings>Extension> changed to 3 seconds

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Min Gap> changed to 3 seconds

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Time Before Reduction> changed to 15 seconds
>Traffic Control Defaults>Timing>Default>Default Phase Settings>Time to Reduce> changed to 0.5 seconds
>Traffic Control Defaults>Timing>Default>Default Phase Settings>Max Green> changed to 60 seconds

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Yellow> changed to 5 seconds

>Traffic Control Defaults>Timing>Default>Default Phase Settings>Memory Mode> changed to non-locking
>Traffic Control Defaults>Timing>Default>Allow Right Turn on Red> unchecked selection

>Traffic Control Defaults>Timing>0ptimization>Minimum Green> changed to 7 seconds

>Traffic Control Defaults>Timing>Optimization>Yellow> changed to 5 seconds

>Traffic Control Defaults>Timing>Optimization>Maximum Cycle Length> changed to 180 seconds
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1769

ATTACHMENT B — MODEL DEVELOPMENT

NCDOT Default Road Class Table

D Desired Speed
01 Freeway 70 Freeway
02 Freeway 65 Freeway
03 Freeway 60 Freeway
04 Freeway 55 Freeway
05 Freeway 50 Freeway
11 Directional Ramp 60 High Compliance
12 Directional Ramp 55 Standard
13 Directional Ramp 50 Standard
14 Ramp 45 Standard
15 Ramp 40 Standard
16 Ramp 35 Standard
17 Loop 30 High Compliance
18 Loop 25 High Compliance
19 Loop 20 High Compliance
21 Arterial 65 Standard
22 Arterial 60 Standard
23 Arterial 55 Standard
24 Arterial 50 Standard
25 Arterial 45 Standard
26 Arterial 40 Standard
27 Arterial 35 Low Compliance
28 Arterial 30 Low Compliance
29 Arterial 25 Low Compliance
31 Collector 60 Standard
32 Collector 55 Standard
33 Collector 50 Standard
34 Collector 45 Standard
35 Collector 40 Standard
36 Collector 35 Standard
37 Collector 30 Low Compliance
38 Collector 25 Low Compliance
39 Collector 20 Low Compliance
41 Local 55 High Compliance
42 Local 50 High Compliance
43 Local 45 High Compliance
a4 Local 40 High compliance
45 Local 35 High Compliance
46 Local 30 High Compliance
47 Local 25 Standard
48 Local 20 Standard
49 Local 15 Standard
51 Roundabout 25 High Compliance
52 Roundabout 20 High Compliance
53 Roundabout 15 High Compliance
54 Roundabout 10 High Compliance
61 Arterial_DDI 45 High Compliance
62 Arterial_DDI 40 High Compliance
63 Arterial_DDI 35 High Compliance
64 Arterial_DDI 30 High Compliance
65 Arterial_DDI 25 High Compliance
66 Arterial_DDI 20 High Compliance
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1781
1782
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1784
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LINKS

NCDOT Congestion Management Section website —
https://connect.ncdot.qov/resources/safety/Pages/Congestion-Management.aspx

e NCDOT Default TransModeler database (current version: NCDOT_Default_09-2016.zip)

e NCDOT Default Project Preferences file (tsm_user.xml)

e NC OneMap Web Map Layer settings files (NCOneMap(Latest)High.xml and NCOneMap(Latest)Low.xml)
e NCDOT Default Road Class Definitions (NCDOT Default File 09-2016 Road Class Definitions.xml)

NC OneMap Aerial Photography —
http://data.nconemap.qgov/qgeoportal/catalog/raster/download.page

NCDOT Functional Classification Map -
http://ncdot.maps.arcgis.com/home/webmap/viewer.html?layers=029a9a9fe26e43d687d30cd3c08b1792

NCDOT Congestion Management Guidelines -
https://connect.ncdot.gov/resources/safety/Congestion%20Mngmt%20and%20Sighing/Congestion%20Manage
ment/Capacity%20Analysis%20Guidelines.pdf

NCDOT Traffic Management and Signal Safety Unit — Design Manual
https://connect.ncdot.gov/resources/safety/its%20and%20signals%20resources/its%20and%20signals%20unit%
20design%20manual.pdf
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